Latitude, Horizon, Meridian
# Table of Contents

1. **Getting Started** ................................................................................................................. 1
   1.1 Version 9.0 Quick Guide to Control Center Skin Changes ................................................. 1
   1.2 Quick Contents ............................................................................................................. 2
   1.3 ControlCenter ............................................................................................................. 3
   1.4 About This File .............................................................................................................. 4
   1.5 Using Help in Control Center .......................................................................................... 5
   1.6 Log On using Command Line ......................................................................................... 5
2. **Workspace** ....................................................................................................................... 9
3. **Application Menu** ........................................................................................................... 11
   3.1 Context Menu ................................................................................................................ 12
   3.2 View/Viewing Mode ..................................................................................................... 16
      3.2.1 Supervisor Mode ................................................................................................... 16
      3.2.2 Monitor mode ....................................................................................................... 17
      3.2.3 Forensic Mode ..................................................................................................... 18
      3.2.4 CaseBuilder Mode ........................................................................................... 19
      3.2.5 Access Control Mode ........................................................................................... 20
   3.3 Tools/Options Menu........................................................................................................ 21
      3.3.1 Content Display .................................................................................................... 21
      3.3.2 Video .................................................................................................................. 24
      3.3.3 View Settings ....................................................................................................... 28
      3.3.4 Export ................................................................................................................. 35
      3.3.5 Scene Tracker ...................................................................................................... 39
      3.3.6 Keyboard ............................................................................................................. 40
      3.3.7 PTZ ..................................................................................................................... 40
      3.3.8 Joystick ............................................................................................................... 41
      3.3.9 Audio .................................................................................................................. 41
      3.3.10 CaseBuilder ......................................................................................................... 42
      3.3.11 Login Settings ...................................................................................................... 42
      3.3.12 Working With Keyboards ...................................................................................... 43
         3.3.12.1 Controlling the ControlCenter via CCTV Keyboard ................................................. 44
         3.3.12.2 Controlling the ControlCenter via the PC Keyboard ...................................................... 48
         3.3.12.3 USB Joystick ................................................................................................... 51
   3.4 Favorites ......................................................................................................................... 52
4. **Explorer Area - Navigation Pane** ................................................................................... 55
   4.1 Navigation Tree ............................................................................................................. 55
   4.2 Query Pane .................................................................................................................... 58
# Table of Contents

4.3 PTZ Pane ................................................................................................. 68
4.4 CaseBuilder Query Pane .......................................................................... 71
    4.4.1 CaseBuilder Navigation Tree Pane ...................................................... 72
4.5 Privacy Mask Password ........................................................................... 74

5. **Display Area - Viewing Pane** ................................................................. 81
    5.1 Layout Tabs .............................................................................................. 81
    5.2 Configuring Layouts ................................................................................ 83
        5.2.1 Thumbnail Search Layout ................................................................. 84
    5.2.2 CaseBuilder Layout ............................................................................. 84
    5.3 Viewing Tile .............................................................................................. 86
        5.3.1 Thumbnail Search ............................................................................ 96
        5.3.2 Using Draw-to-zoom with Thumbnails .............................................. 96
        5.3.3 Digital Presets ................................................................................ 97
            5.3.3.1 Defining Digital Presets ................................................................. 97
            5.3.3.2 Using Digital Presets ................................................................. 99
        5.3.4 Quick View ..................................................................................... 100
            5.3.4.1 Quick View enabled in a Pane .................................................... 101
            5.3.4.2 Using Quick View ..................................................................... 102
            5.3.4.3 Quick View - further details ...................................................... 104
            5.3.4.4 Quick View in Playback ............................................................ 104
        5.3.5 Controlling Output Pins linked to Cameras ........................................ 105
        5.3.6 Adaptive Streaming ......................................................................... 106
        5.3.7 Hide/Show Privacy Mask (Deactivate) ............................................. 106
        5.3.8 Spot Monitor .................................................................................... 109
        5.3.9 Viewing GIS Maps .......................................................................... 109
        5.3.10 Panoramic Cameras ........................................................................ 111
        5.3.11 Viewing Live and Recorded Video from connected DVRs .......... 113

5.4 Viewing Modes for Alarms ...................................................................... 114
5.5 Synchronized Playback ............................................................................ 119

6. **Workspace Panes** .................................................................................. 123
    6.1 Query Results Pane .............................................................................. 124
    6.2 Clips Pane ............................................................................................... 125
    6.3 Timeline .................................................................................................. 128
        6.3.1 Selecting a clip ............................................................................... 129
        6.3.2 Scrubbing ....................................................................................... 130
        6.3.3 Timeline scale and Viewing point ................................................... 131
Table of Contents

6.4 Export Status Pane ................................................................................................... 133
  6.4.1 Exporting a Clip .............................................................................................. 133
  6.4.2 Loop Playback .................................................................................................. 138

6.5 Events Pane ......................................................................................................... 138

6.6 Alarms Pane ......................................................................................................... 139
  6.6.1 Displaying a Camera on Alarm (Automatic and Manual) ................................ 142

7. Cases - CaseBuilder Features ................................................................................. 145
  7.1 Building a Case in CaseBuilder Mode .............................................................. 146
    7.1.1 Adding an Existing Clip to a Case ............................................................... 146
    7.1.2 Adding an Existing Clip Bookmark to a Case .............................................. 147
    7.1.3 Adding a New Snapshot (on-the-fly) to a Case ............................................ 148
      7.1.3.1 Adding an Existing Alarm to a Case ..................................................... 149
      7.1.3.2 Adding a Clip Segment to a Case .......................................................... 150
    7.1.4 Adding an Existing Incident to a Case ...................................................... 151
    7.1.5 Adding a File to a Case (documents, images, exports, etc.) ....................... 152
      7.1.5.1 Adding an Existing Snapshot to a Case (Monitor-Tile) ........................ 153
    7.1.6 Adding a URL to a Case ............................................................................... 153
  7.2 Opening a Saved Case ......................................................................................... 154
    7.2.1 Opening and Viewing an Exported Case ...................................................... 154

7.3 Exporting a Case .................................................................................................. 155
    7.3.1 Adding an Exported DVT Clip to a Case .................................................... 155

7.4 CaseBuilder Options ............................................................................................ 156
1 Getting Started

1.1 Version 9.0 Quick Guide to Control Center Skin Changes

Upon Startup, or if you want to re-populate your layout at any time, go to the View menu, and use the dropdown there to choose options in the Default Layout, Viewing Modes, Content Panes, and Full Screen Dropdowns.

How the Panes and Tabs are positioned

Where did they go?

UVMS 8x

UVMS 9
1.2 Quick Contents

**Application Menu**
- Context Menu
  - View/Viewing Mode
  - Supervisor Mode
  - Monitor mode
  - Forensic Mode
  - CaseBuilder Mode
  - Access Control Mode

**Tools/Options Menu**
- Content Display
- Video
- View Settings
- Export
- Scene Tracker
- Keyboard
- PTZ
- Joystick
- Audio
- CaseBuilder Login Settings

**Favorites**
- Working With Keyboards
  - Controlling the ControlCenter via CCTV Keyboard
  - Controlling the ControlCenter via the PC Keyboard
  - USB Joystick

**Explorer Area - Navigation Pane**
- Navigation Tree
- Query Pane
- PTZ Pane
- CaseBuilder Query Pane
- CaseBuilder Navigation Tree Pane
  - Privacy Mask
  - Password

**Display Area - Viewing Pane**
- Layout Tabs
- Configuring Layouts
- Thumbnail Search Layout
- CaseBuilder Layout

**Viewing Tile**
- Thumbnail Search
- Using Draw-to-zoom with Thumbnails
- Digital Presets
  - Defining Digital Presets
  - Using Digital Presets
- Spot Monitor
- Quick View
  - Quick View enabled in a Pane
  - Using Quick View
  - Quick View - further details
  - Quick View in Playback

**Workspace Panes**
- Query Results Pane
- Clips Pane
  - Timeline
  - Selecting a clip
  - Scrubbing

**Events Pane**
- Alarms Pane
  - Displaying a Camera on Alarm (Automatic and Manual)

**Cases - CaseBuilder Features**
- Building a Case in CaseBuilder Mode
  - Adding an Existing Clip to a Case
- Opening a Saved Case
- Opening and Viewing an Exported Case
- Exporting a Case
- Adding an Exported DVT Clip to a Case
Getting Started

**Timeline scale and Viewing point**

**Export Status Pane**

- Exporting a Clip
- Loop Playback

---

### 1.3 ControlCenter

![Control Center General View](image)

*Fig 1 - Control Center General View*
The **ControlCenter** gives users a highly customizable platform for viewing live and recorded video.

**Features include:**

- Each ControlCenter allows the user to view up to sixteen live and archived video sources per monitor, with multiple monitors supported on each workstation.
- Full control of content playback with powerful time line controls
- Powerful query capability to assist in locating specific content or identifying recordings associated with motion events
- Monitoring and management of alarms
- With proper hardware and encoders (or IP cameras) video can be viewed at full motion (30 fps NTSC, 25 fps PAL) 4CIF quality.
- Detailed Help information on all facets of the system. Click [here](#) to see details of how to use the Help features.

**Other major features of the application include:**

- Audio and video independence. Audio inputs and outputs are no longer tied to a video source. The relationship between the two types of media in the system has been transformed from one-to-one to many-to-many, giving users the ability to mix audio sources and link any combination of such sources to multiple camera scenes.
- Sequences and Guard tours allowing multiple scenes to be shown in predefined sequences and for defined durations.
- PTZ Control and Digital Zoom - integrated into a single intuitive interface, which allows users to easily take advantage of the best available tool without having to switch windows. Digital and analog PTZ functions can also be controlled directly from the tile using a mouse with a scroll-wheel.
- Multiple-source bookmarking. Bookmarks are now augmented by incidents, a powerful feature that allows users to associate multiple media sources to a single occurrence simply by highlighting multiple tiles prior to clicking the bookmark button. The set of bookmarks created this way constitutes a single incident.
- Full alarm management capabilities.
- Inter maps. Multiple maps and web pages can now be placed in each site.
- Instant replays with or without alternative content arming. The user can choose to allow instant replay of the buffered video either in the next available tile or only in armed tiles specified for alternative content. Alternative content tile arming is similar to alarm arming but used for instant replays. This allows users to determine in advance where and how the alternative content will be displayed.
- Workspace customization. The location and size of all workspace areas other than the Application Menu can be modified.
- Simplified and enhanced navigation. All logical entities are now shown in a single Navigation Tree.

### 1.4 About This File

Welcome to the United VMS 9.0.1 Control Center Help File.

**Note:** Changes to this file were last introduced after Application Build No: 3004

WindowBlinds: DirectSkin™ Stardock®

**Summary of latest changes:**
In version 9.0.1:

<table>
<thead>
<tr>
<th>Change</th>
<th>Date</th>
<th>Summary</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick View</td>
<td>Oct 2020</td>
<td>The Control Center <strong>Quick View</strong> functionality is described.</td>
<td><a href="#">Quick View and following topics</a></td>
</tr>
<tr>
<td>Output Pins</td>
<td>Oct 2020</td>
<td>Controlling Output Pins from the Control Center</td>
<td><a href="#">Controlling Output Pins linked to Cameras</a></td>
</tr>
<tr>
<td>Query, Play, Export Multiple Clips</td>
<td>Oct 2020</td>
<td>User can select multiple clips</td>
<td><a href="#">Query Results Pane, Exporting a Clip, Synchronized Playback</a></td>
</tr>
<tr>
<td>EST-Enabled Cameras</td>
<td>Nov 2020</td>
<td>EST-enabled cameras can generate Screening Events</td>
<td><a href="#">Viewing Tile</a></td>
</tr>
</tbody>
</table>

**Please note:** This is not a formal Change Register - the list is included so that users can quickly access Topics that contain new or changed information. **Please note:** This is not a formal Change Register - the list is included so that users can quickly access Topics that contain new or changed information.

---

### 1.5 Using Help in Control Center

**Accessing the Help file**

Clicking on Help in the Main menu Bar lets you access the Help button.

---

### 1.6 Log On using Command Line

The Control Center is normally loaded on the local machine by the user by clicking on the Control Center icon.

For instances where the Control Center does not have a dedicated operator (for example, where it operates purely as a display manager), it may be convenient to start the application and log in using the Command line.

⚠️ **Note:**

1. The processes described below will not work if the Control Center is already running on the workstation.
2. Each of the following instances refers to a NEW installation. For systems that have been upgraded from previous versions, the file path begins:
C:\Program Files (x86)\DVTEL...

Control Center Log On to a single directory
The following syntax is required:
"C:\Program Files\FLIR\<%SOFTWAREPREFIX%>\ControlCenter\ControlCenter.exe"
-u="admin" -p="password" -s="server-address"

Control Center Log On to multiple directories
Where multiple directories are needed, the addresses of all the required servers should be entered:
"C:\Program Files\FLIR\<%SOFTWAREPREFIX%>\ControlCenter\ControlCenter.exe"
-u="admin" -p="password" -s="server-address1 server-address2 server-address3 ...

Automatically Running Activities after Log On using Command Line
In order to run a command to open ControlCenter upon computer start:
1. Open Task Scheduler
2. Create Task
3. Enter a name for the Task
4. Go to Triggers
5. Create a new Trigger
6. Choose Begin the task “At startup” or “At log on”
7. Optional and recommended – mark “Delay task for 1 minute” – so the computer can get ready after startup
8. Press OK (saves the Trigger)
9. Go to Actions
10. Create a new action
11. Choose action: Start a program
12. Enter the ControlCenter.exe path:
   C:\Program Files (x86)\<%SOFTWAREPREFIX%>\ControlCenter\ControlCenter.exe
13. Add arguments:
    -u="Username" -p="Password" -s="Server1 Server2 Server3" (or substitute 
    “Encrypted Password” - See below)
14. If you get a pop-up regarding the text in the arguments, choose the “No” option
15. Press OK (Saves the Action)
16. Press OK (Saves the Task)

Logging On via Command Line using Encrypted Password
⚠️ Caution When using Command Line Log On, the text and arguments of the process are readable to any operator of the target Control Center machine. In order to prevent exposing the normal User
password, it is recommended to use the following process that creates an encrypted version of the password.

**In order to encrypt a password:**

1. Open CMD
2. Enter command:
   ```
   cd C:\Program Files\FLIR\<%SOFTWAREPREFIX%>\Tools\PasswordEncryptor
   ```
3. Enter command:
   ```
   [Application folder].PasswordEncryptor.exe Password
   ```
4. Go to `C:\Program Files\FLIR\[Application folder]\Tools\PasswordEncryptor` folder
5. The file “encrypted.txt” contains your encrypted password

**Using the Encrypted Password**

In the **Startup arguments** above, use the text in the `encrypted.txt` file as the password in the Password argument.

This password text will only work for the Command Line Log On. If an operator tries to use this encrypted password to gain regular access to a client workstation through the Login screen, it will not be accepted.

**Choosing a Layout to be used for a Command Line Log On**

These processes have been created as part of the Multi-Directory Tools which allow the user to define and run Activities on a Control Center that is started using the Command Line.

2 Workspace

One of the major features of ControlCenter is that the workspace is almost entirely customizable by the user. Only the menu area at the top of the screen is static -- every other pane can be moved or hidden. The example below shows a typical layout:

The following links provide detailed information on the main components in the ControlCenter screen:

- **Menu Area**
- **Viewing Pane** - used to display cameras, sequences, alarms, maps, instant replays and archived video clips. It is also used to receive and transmit audio. The **Layout** tabs, located at the top of the pane, allow the user to access the different available layouts.
- **Navigation Pane** - used to browse for logical system entities and display or play them in the Viewing Pane or through external output devices (i.e. analog monitors and speakers). The following panes can be displayed below the Navigation Pane (or can replace it)
  - **PTZ Pane** - used to control PTZ cameras/domes and digital zoom
  - **Query Pane** - used to search for archived scenes based on a scene; date and time; and recording trigger
- **Workspace Pane**: This area can contain any of the panes below (but only one at a time)
  - **Alarm Pane** - used to trigger alarms and to handle them
  - **Events Pane** - displays events the user has been configured to receive
  - **Timeline** - shows the active viewing tile’s time line and can be used to quickly browse through a video or audio clip, and export a partial or whole video clip.
  - **Query Results** - displays the results of the query and allows users to review them in the Viewing Pane or via analog monitors.
Other panes that can be opened by clicking on their corresponding icon in the ControlCenter screen are as follows:

- **Navigation Tree** is used to create new cases, open exported cases and manage them.
- **Export Status Pane** displays the status of exported clips during their export and after the export is completed and can be used to stop exports.
- **File Playback Pane** synchronously plays and validates exported clips.
- **CaseBuilder Query Pane** * is used to search for cases based on case name, serial number, the user who created the case or free text.

* **Note: Only available when connected to a Latitude system**
3 Application Menu

The Menu area (Application Menus) is the only part of the workspace whose size and position are not user-modifiable. It consists of four menus.

**File**

The file menu allows users to exit the application, connect or disconnect from the system and change their password and open an exported DVT clip.

**View**

This menu allows users to: show/hide the default audio and video layouts of the viewing pane, select preset viewing modes, choose which panes to display (the viewing pane cannot be hidden), and enter full screen mode.

To view the contents of the viewing mode section, see Viewing Mode.

**Tools**

This menu is used to open the Options window, from which a number of application settings are configured.

To view the contents of the Options dialog box in detail, see Options Menu.
Favorites
Favorites allows the user to create and save additional custom workspace configurations to best suit his security environment and maximize operation efficiency.

To view the contents of the viewing mode section, see Favorites.

Help

This menu is used to show open the Help File, allow the operator to check whether Updates are available for the ControlCenter software and to see the information held in the About screen.

3.1 Context Menu

Right-clicking on any viewing tile or on the navigation tree opens a Context Menu.

The Context Menu varies depending on the contents of the window from which it was opened.
For example - when watching a Live camera, the context menu shows the option of ‘Send to Query’ so the user can search for clips from that camera.
When the user is watching a recording, the context menu removes that option, and shows ‘Switch to Live’.

This is a list of all the Context Menu entries.

<table>
<thead>
<tr>
<th>Context Menu Item</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show only this tile/All tiles</td>
<td>Changes this tile to a single-tile display</td>
</tr>
<tr>
<td>Take Snapshot</td>
<td>Saves a snapshot of the video from the selected tile in the default export folder defined in the Tools menu. Snapshots are saved as .png files.</td>
</tr>
</tbody>
</table>
| Print Snapshot | Prints a snapshot of the video from the selected tile. See Print Snapshot Dialog  
**Note:** In order to use this function, the ‘Export’ Privilege must be set in the User/Privileges screen |
| Lock/Unlock tile | No other content can replace this until the ‘Lock Tile’ check is removed |
| Show my Location | An open GIS map will be repositioned to show this camera in the center of the view tile. (Requires that GIS location has been stored for a camera and a GIS Map has been defined) |
| Spot monitor | Clicking on Spot Monitor defines this tile to be the destination for any video opened by double-clicking on a camera in the Navigation tree or a clip in the Query list.  
The Spot Monitor will also be used when video from a remote ControlCenter is to be shown.  
**Note:** Only one tile can be set as the Spot Monitor at any one time. |
| Enter/Exit Full Screen | Displays this tile in full-screen mode. Revert by right-clicking again and selecting ‘Exit Full Screen’, or otherwise press ‘Esc’ |
| Remove | Clears this tile |
| Switch to Digital/Optical PTZ | PTZ cameras only - activates digital PTZ functionality, taking current PTZ position as starting point |
## Context Menu Item

<table>
<thead>
<tr>
<th>Context Menu Item</th>
<th>Comments</th>
</tr>
</thead>
</table>
| **Activate/Deactivate Privacy Masking** | Allows the operator to remove/replace the Privacy Mask  
(System Administrator sets whether operator/s have access to this option) |
| Clear                             | (ioi units only)  
Clears the current state of the ioi camera |
| Save as preset                    | If the user has used the in-pane controls to change the view in a viewing tile, the resulting view can be saved as a digital preset |
| Go to preset                      | If digital presets have been saved for the camera being displayed in this viewing pane, the user can select them by clicking on Go to preset, and then selecting the required view. |
| Adaptive Streaming                | Activate/Deactivate Adaptive Streaming (saves bandwidth when displaying video in smaller tiles) (Only for supported devices) |
| Send to Query                     | Sets the selected unit as a filter in the Query pane so that all recordings from that unit can be selected |
| Switch to Live                    | Changes contents of the tile from Recorded content to the live view of the same camera.  
**Note:** For regular playback - not available when playback is Synchronized, Thumbnail mode, or triggered by an Alarm |
| Start/Stop Manual record          | Only in Nav. Tile menu – same function as clicking the Record button in a camera tile. |
| Display                           | Only in Nav. Tree menu – Displays video from this camera in the next available tile |
| Instant Replay                    | Only in Nav. Tree menu – Starts replay of Manual recording in next available tile that is armed to show replays. |

## Analytics-Related Context Menu Entries

<table>
<thead>
<tr>
<th>Context Menu Item</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Batch Arm/Disarm  | *(Shown in the Context Menu when the System is selected in the Navigation Tree)*  
Opens the Batch Arm/Disarm dialog box, listing all Analytics-capable cameras, and allowing the user to arm or disarm Analytics in one or more cameras |
| Arm/Disarm        | *(Shown in the Context Menu when an Analytics-enabled camera is selected in the Navigation Tree)*  
Allows the user to arm or disarm Analytics in the selected Analytics-capable camera |

The Analytics arming status of individual cameras is shown in the Navigation tree.
Batch Arm/Disarm Dialog

When using ioi Analytics-enabled cameras, the user can open a Batch Arm/Disarm Dialog box to arm or disarm the Analytics feature in one or more cameras.

Print Snapshot Dialog

If the Print Snapshot option is clicked in a Viewing Tile Context menu, then the Print Snapshot Dialog box is opened, allowing the user to set the required Print parameters.

Note: When printing a larger image (high resolution video) than the size of the page used for printing, the image will be scaled down to fit to page.
3.2 View/Viewing Mode

The ControlCenter user can easily manage different tasks by adjusting the application workspace in a single button click.

To select the mode you want to use:
Access the View > Viewing Mode section from the Application Menu, and then click the desired mode

- **Supervisor mode** – adjusted for a supervisor overview of the security environment
- **Monitor mode** – for live video and audio monitoring
- **Forensic mode** – optimized for searching and reviewing of recorded information
- **CaseBuilder mode** – an authoring tool used to collect and review recorded data in specific cases
- **Access Control mode** – optimized for real-time handling of Alarms and Events

See Quick summary of Control Center UI changes

3.2.1 Supervisor Mode

In the Supervisor mode, the following panes appear:

- **Navigation Pane**
3.2.2 Monitor mode

In the Monitor mode, the following panes appear:

- **Navigation Pane**
- **PTZ Pane**
- **Alarms Pane**
- **Viewing Pane**
### 3.2.3 Forensic Mode

In the Forensic mode, the following panes appear:
- **Query Pane**
- **Query Results Pane**
- **Viewing Pane**
### 3.2.4 CaseBuilder Mode

**Note:** Only available when connected to a Latitude system

In the CaseBuilder mode, the following panes appear:
- CaseBuilder Navigation Pane
- CaseBuilder Query Pane
- Query Results Pane
- Viewing Pane
3.2.5 Access Control Mode

In the Access Control mode, the following panes appear:

- Navigation Pane
- Query Pane
- Combined Alarms Pane & Events Pane
- Viewing Pane
3.3 Tools/Options Menu

Options Navigation Tree

Using the Options menu, you can customize your ControlCenter Settings.

To access the Options menu, select Tools / Options from the Application Menu.

Use the Options Navigation Tree to access the customizable parameters.

3.3.1 Content Display

There are four sub-menus in this category: Alarms, Events, Timeline and Query.

Alarms

The Alarms sub-menu is used to set the General Settings and the Display Settings parameters:
Note: If the Accepted alarms only radio button is selected, a warning pop up appears reminding you to restart the system.

In the General Settings field:

- **Queue size**: Determine the number of alarms displayed in the alarm queue.
- **Snooze time**: Determine the time span after which the alarm is triggered again when the Snooze button is clicked.
- **Play alarm sound**: Determine whether to play a sound when an alarm is triggered.

In the Display Settings field:

- **Alarms pane color indication**: Determine whether to give color indication to an Entire Column or to a Priority Column Only.
- **Alarms sequence display option**: Determine whether to Show All Alarms or to show Accepted Alarms Only.
- **Maximize on alarm**: Determine whether to maximize the alarm pane when an alarm is triggered.

**Events**
The Events sub-menu is used to specify how many events are shown in the Events pane.
Timeline

The **Timeline** sub-menu is used to specify whether to **Show Motion** in the Timeline pane.

Query

The **Query** sub-menu is used to set the following parameters in the Query Results pane:

- **Query Max Results** - Determine the maximum number of results shown in the Query Results pane.
- **Motion Query** - specify the motion strategy used in motion-based searches (either higher bound or lower bound).
- **Offline Query** - select the check box to optimize offline query.
3.3.2 Video

The Video Options screen has three sub-menus: General, Instant Replay and Playback.

General

The Video General sub-menu is in two sections - Settings and Quality:
### Settings

#### Maintain Aspect Ratio

- **Maintain Aspect Ratio** (default ON) This controls how video scenes are shown in the ControlCenter.

When Maintain Aspect Ratio is checked, the display has ‘frames’ to fill the unoccupied portions of the tile.

When Maintain Aspect Ratio is unchecked, the display is stretched to fill the available tile.

**Note:** This setting can be toggled in real time for individual tiles by selecting the tile and clicking Shift-R.

#### Adaptive Streaming

- **Adaptive Streaming** (default ON) - This allows the system to choose the optimum available stream from a camera, depending on the size of its viewing tile. The system selects a high-resolution stream when the image is shown in larger tiles or full-screen mode. When the viewing tile is smaller, not so much resolution is needed, so a lower-resolution stream can be chosen.

Adaptive Streaming is currently available with FLIR and DVTEL's Ariel, Quasar, and Quasar Gen 2 edge devices.

Adaptive streaming is enabled by default, but can be disabled on each Control Center by un-checking this box. It may also be disabled for an individual camera using the Context Menu in an open camera Viewing Tile.
Quality

The system uses various video filters to improve the appearance of displayed scenes. Filters consume system resources, so the user has the option to switch them off on client machines that performance limitations.

The **Video Quality** sub-menu specifies whether the following filters are applied:

- **Dejittering** (default ON)
  Dejittering uses memory buffers to make the video presentation smoother. On Client machines with limited memory, this filter can be switched off, which reduces memory consumption, but might impact video quality.

- **Deblocking** (default ON)
  The deblocking filter is applied to decoded compressed video to improve visual quality while decoding video.

- **Deinterlacing** (default ON)
  Deinterlacing is the process of converting interlaced video, such as 1080i format HDTV signals, into a non-interlaced form.

Instant Replay

The **Instant Replay** sub-menu is used to set the rewind time before a replay (in seconds).

The **Tile arm settings** lets the user define whether instant replay is done in a video tile specified by "Arming it for alternative content" as the playback tile or whether the playback will default to the next available tile. If no tile is available, this will be the first tile.
The **Instant Replay source** allows you to choose if, when using Instant Replay, to always use the camera’s ‘alternative scene’ for IR. Normally, clicking on Instant Record for a camera will result in a recording being made from the Live camera stream, using its resolution parameters. When the camera has been defined as ‘Dual Scene’, clicking on this option allows the IR function to use the alternative stream - thus the IR clip will be at the ‘Recorded Stream’ resolution.

**Playback**

The **Playback** sub-menu is used control the load imposed on the client machine during playback. Defaults are set for dealing with lower number of streams, but higher quality. If a client machine is experiencing load issues, the operator can change settings to provide higher throughput, but possibly impacting on video quality.

The user can set the type of online playback (**TCP** or **UDP**), **smooth playback**, **streaming buffer length**, **the number of scenes that can be played synchronously**, and **max. number of CPU cores to be used during decoding**.

These settings are unique to the specific client machine on which they are set, so the user can ‘tune’ specific workstations depending on the power of the client machine, and whether it is more important to keep high quality playback, or allow more streams to be handled.

### TCP/UDP

Default setting is **TCP**. UDP will allow more streams to be played, but this may allow dropped frames.

### Offline Playback

Fast playback normally displays only key frames. This may provide some jerkiness in the image.

When **Enable smooth reverse playback** is enabled, playback is not limited to only key-frames but displays all video frames. This prevents the jerky motion that can occur during reverse playback. This option requires TCP playback.

**Note:** Smooth playback is not supported on Transcoded video.
Additionally, Smooth playback can be enabled independently for online and offline playback

**Synchronized Playback**
Default set to 6 streams. If higher quality playback is required, the number of simultaneous synchronous streams should be reduced.

**CPU Utilization**
By default, this is set to 2. The maximum number of cores that is available will correspond to the number of cores on the computer being utilized (and hence can vary on Control Center applications being run on different computers.).
If only one or two streams are to be watched fast forward/reverse, then the number of cores to be used may be increased to the maximum available on the target machine.

**Note: Playback of final frames of a clip:**
Under certain specific conditions, when using multiple CPU cores (see CPU Utilization parameter), then the final \((n-1)\) frames will not be played back (where \(n\) is the number of cores specified in the CPU Utilization parameter).
This will occur if the following conditions are satisfied:
- This is the final clip available for the device (No later clips exist), and
- A single stream is being played (not Synchronized Playback), and
- The ‘Smooth Reverse Playback’ parameter is unchecked.
If the user needs to see the final frames:
- Use the Pause and Play controls to play the frames individually, or
- Reset the number of cores to be used can be reset to 1 in the Tools/Options/Video/Playback menu, and start the playback again.

### 3.3.3 View Settings
The sub-menus in this category are: General, Full Screen, Layout, Advanced, Layout Patterns, OSD, Tile Toolbar and Notifier.

**General**
The General sub-menu specifies the global screen parameters for this ControlCenter.
The **General** section shows icons for each of the display screens attached to the ControlCenter. The check-box in each top left corner is used to indicate that the corresponding screen is to be used for the ControlCenter display. When a screen icon is checked, the corresponding entity number is shown.

- The **Status bar** check-box is used to control whether the Windows Status Bar is to be shown or not.
- The **Navigation Tree** check-box controls whether the Navigation tree entry for an entity should be shown in **bold** when that entity is displayed in the ControlCenter or not.

**Full Screen**

The Full Screen sub-menu is used to specify which GUI elements should be shown in full screen mode.

**Layout**
- **Dwell Time** - Is used to specify the how long each layout should be displayed during layout tours (the dwell time).

- **Drag Behavior** - Is used to indicate if a stream should be removed by dragging it out of the layout.

- **PIP Behavior** - Is used to enable/disable the ability to show a Picture in Picture view of a camera with multiple streams (dual Thermal/visible PTZ, Multi-imager with 5th lens, etc.)

**Advanced**

The Advanced sub-menu is used define the stack length, stream disposal, Limits on system resources, and control on video retries.
Limits on system resources

- **Check-box** to limit Maximum Number of Active Video Tiles and Value - by default this box is unchecked (disabled), as the normal setup will use the Memory usage flag (below)

- **Check-box** to activate limit flag on CPU Usage - by default this is checked (enabled) and default value is 90%

- **Check-box** to set level at which to flag Memory usage - by default this is checked (enabled) and default value is 90%

When invoking a new function that will require memory resources, a message is displayed that gives the user the option to take steps to reduce memory usage such as reducing the number of viewing tiles, before invoking the next instruction.

When the defined memory usage level is reached, a warning message is displayed.

Layout Patterns

The Layout Patterns sub-menu is used to determine which layout patterns are available. Move the desired layouts from the Available list to the Selected list using the arrows.
OSD

The OSD sub-menu is used to set the font and background parameters of the information displayed on screen and determine what information is displayed. You can select to display the scene name, status description, status image, video statistics and time.
Metadata General

The Tile Toolbar sub-menu is used to determine the opacity level of the toolbar background and buttons as well as the visibility of the tile toolbar and the tile number. By default, the toolbar background is very opaque and it fades when the cursor is not placed on top. The buttons are visible and the Armed Tile button is always visible.
Notifier
The Notifier sub-menu is used to determine whether the message notifiers, display timers, displays on alarms and displays on errors should be visible.

Event Display
The Event Display sub-menu is used to select which event types will be displayed.
3.3.4 Export

There are three sub-menus in this category: Snapshot, Clip and Burn.

The Clip sub-menu sets the default export format (.dvt, .mp4 or .avi). If required, these settings can be over-ridden in the Export dialog at the time a specific export is initiated.

Snapshot

The Snapshot sub-menu is used to set the following snapshot export parameters:

- **Saved Location** - Determine the location of the export folders.

*Note:* This can also be done using an environment variable such as %temp%. 
- **Snapshot title format** - Determine the title format of the snapshots. To export snapshots without captions, delete the title in this field.

![Options](image)

**Clip**

The **Clip** sub-menu is used to set the clip export parameters.

![Options](image)

- **Saved Location** - Set the location of the export folders.
- **Create new folder for each export** - Select this check box to create a separate folder for each exported clip.
- **Create autorun file** - Select this check box to create an autorun file for all exported files to automatically run the files after they are burnt on a disk.
- **Include player** - Select this check box to automatically export and burn an executable player along with exported files that are burnt on a disk.
- **Max File size** - allows the user to set a maximum clip size.
• **Time Segment** - The duration of the exported clip. This parameter is only applicable when exporting from the query results pane, since export from the timeline requires specifying start and end points.

• **Advanced mode** - Select the advanced mode check box to access the export settings from the Query pane when exporting a clip. By default, this option is selected. If unchecked, the user does not have the option of changing the parameters at export time.

**For more information,** see [Exporting a Clip](#).

---

**Format, Bookmark and OSD**

Within the Clip menu there are three sub-menus: **Format**, **Bookmark** and **OSD**

**Format**

The **Format** sub-menu is used to determine the clip format. The available options for the related fields (Embed OSD, Video and Audio Codec, Interleaved Export) change depending on which format is selected.

**Note:** When using the default option of NOT embedding the OSD, if the clip is around 15 minutes or longer the subtitles update once every second to reduce delay.

**Note:** When selecting to embed OSD into MP4 clips, it is recommended that the user only use this option for short clips

**Note:** Interleaved (video and audio) export is checked by default for all formats.

---

The **Bookmark** sub-menu displays the export settings of the Bookmark Clip.
The **OSD** sub-menu is used to set the font and background parameters of the information displayed on screen to determine what information is displayed.

The **Burn** sub-menu enables you to burn the Exported files and if required, to delete these files at the end of the burn operation.

The **Burn** dialog box contains these fields:

**Temp Burn Location:**
Click the browse icon to specify a temporary location for the burned file

-or-

Mark the check box to use a default location.

**Delete Files After Burn** Operation: mark this check box if you want to delete the files after the burn process is complete.

### 3.3.5 Scene Tracker

**Note: Only available when connected to a Latitude system**

The **Scene Tracker** menu is used to select the **Video Quality** and whether to flip the video frame.
3.3.6 Keyboard

The **Keyboard** menu is used to specify the type and port address of a keyboard connected to the client machine's RS232 serial port, as well as whether keyboard beeping should be enabled.

![Keyboard Menu](image1)

3.3.7 PTZ

The **PTZ** menu is used to determine whether to display a message informing the user about overriding a PTZ lock.

![PTZ Menu](image2)
3.3.8 Joystick

The Joystick menu is used to select the joystick type and determine the joystick settings.

For more information, see USB Joystick.

3.3.9 Audio

The Audio menu is used to select the Audio Capture Device, determine whether to mute the attached audio, and set the default volume.
3.3.10  CaseBuilder

Note: Only available when connected to a <%HOSTSYSTEM%> system

The CaseBuilder menu is used to set the Bookmark Clip settings (i.e. how long before and after the Bookmark the clip should be saved, the lifespan of Cases and the warning for Clip Duration Limitation.

3.3.11  Login Settings

The Login Settings menu is used to determine whether the login settings should be saved.
3.3.12 Working With Keyboards

CCTV keyboards can be connected to a client PC's RS232 serial port. Since the connection is local, the use of a keyboard does not have an effect on privileges. Some functions, however, may not be available on some or all supported keyboards.

Keyboard settings can be configured by going to **Tools -- Options** and clicking the **Keyboard** tab in the **Options** dialog box.

Command sequences for common tasks:

<table>
<thead>
<tr>
<th>Function</th>
<th>PTZ Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch to a viewing pane or analog monitor with logical ID X.</td>
<td>X MON</td>
</tr>
<tr>
<td>Switch to a tile Y within the selected viewing pane.</td>
<td>Y MON</td>
</tr>
<tr>
<td>Switch to tile Y of viewing pane X.</td>
<td>Y MON, X MON</td>
</tr>
<tr>
<td>Display camera X on the focused tile/analog monitor or switch the viewing pane layout to layout X.</td>
<td>X CAM</td>
</tr>
<tr>
<td>Operate a PTZ camera displayed on the focused tile/analog monitor.</td>
<td>Joystick and dedicated PTZ buttons (IRIS, PRESET, etc.)</td>
</tr>
</tbody>
</table>

Additional controls are available through the FLIR Inc CCTV keyboard or the PC keyboard of the Workstation running the Control Center Client Application.
For complete information, see Controlling the ControlCenter via CCTV Keyboard and Controlling the ControlCenter via the PC Keyboard.

3.3.12.1 Controlling the ControlCenter via CCTV Keyboard

Using the CCTV keyboard, you can control the ControlCenter application (both local and remote).

Selecting and Controlling Entities and Tiles

All entities (cameras, camera sequences, tiles, layouts, monitors, etc.) have a unique ID represented by a logical number (xxxx).

DVT-KBD-G2

Keyboard Commands:

**Note:** The SHIFT button works as a toggle for other buttons on the keyboard. When SHIFT is used to trigger a function, it remains in the SHIFT state until the button is pressed again to toggle back to the previous mode.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Command</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a Control Center Monitor</td>
<td>Monitor Number → MULT</td>
<td>8</td>
</tr>
<tr>
<td>Select a View tile</td>
<td>Monitor Number → MULT</td>
<td>8</td>
</tr>
<tr>
<td>Display a camera on the selected monitor or tile</td>
<td>Tile Number → CAM</td>
<td>7</td>
</tr>
<tr>
<td>Toggle through viewing pane layouts with 4 tiles</td>
<td>2 → SETUP</td>
<td>2</td>
</tr>
<tr>
<td>Toggle through viewing pane layouts with 9 tiles</td>
<td>3 → SETUP</td>
<td>2</td>
</tr>
<tr>
<td>Toggle through viewing pane layouts with 16 tiles</td>
<td>4 → SETUP</td>
<td>2</td>
</tr>
<tr>
<td>Expand currently selected tile to fill viewing pane</td>
<td>MULT</td>
<td>8</td>
</tr>
<tr>
<td>Clear currently selected tile</td>
<td>SHIFT → CAM</td>
<td>3+7</td>
</tr>
</tbody>
</table>
Display a sequence on the selected monitor or tile | Sequence number → TOUR | 19
Pause Sequence | TOUR | 19
Switch to next camera of a paused sequence | SHIFT → FOCUS+ | 3+13
Switch to previous camera of a paused sequence | SHIFT → FOCUS- | 3+13
Turn recording of the selected camera's video stream on/off | SCAN | 17
Audio PTT | OTHER | 15
Audio Listen | SHIFT → OTHER (enabled by default) | 3+15
Trigger an alarm | Alarm Number → PAN | 18
Acknowledge alarm in active tile | SHIFT → PAN | 3+18
Full Screen | 11 → FN | 11+5
Display CC Help File | 1 → FN | 1+5
Switch between Systems (while logged in to multiple systems) | System number → SHIFT → MULT | 3+8

**Instant Replay Commands:**

**Note:** Moving the joystick will pause the video, moving the joystick to the left or right will move the playback needle within the time-line. When a desired spot is determined, press PLAY to continue watching.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Command</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Instant replay on next available tile</td>
<td>PLAY</td>
<td>11</td>
</tr>
<tr>
<td>Play</td>
<td>IRIS +</td>
<td>12</td>
</tr>
<tr>
<td>Pause</td>
<td>IRIS -</td>
<td>12</td>
</tr>
<tr>
<td>Rewind</td>
<td>FOCUS - or joystick left</td>
<td>13/21</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>FOCUS + or joystick right</td>
<td>13/21</td>
</tr>
<tr>
<td>Bookmark the selected tile</td>
<td>SHIFT+SCAN</td>
<td>2+17</td>
</tr>
</tbody>
</table>

**Controlling PTZ Domes:**
**Note**: Entering the PTZ menu, by pressing the PTZ Button (10) will display a menu with the options listed below as **PTZ**.

To learn more about navigating the menu, see the *UVMS_Keyboard_DVT-KBD-G2_UIG*.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Command</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan left/right</td>
<td>Joystick left/right</td>
<td>21</td>
</tr>
<tr>
<td>Tilt up/down</td>
<td>Joystick up/down</td>
<td>21</td>
</tr>
<tr>
<td>Zoom in/out</td>
<td>ZOOM +/-</td>
<td>21</td>
</tr>
<tr>
<td>PTZ preset</td>
<td>Preset Number → PRESET</td>
<td>16</td>
</tr>
<tr>
<td>PTZ Pattern</td>
<td>Pattern Number → PATTERN</td>
<td>20</td>
</tr>
<tr>
<td>Send to 'home' position</td>
<td>PTZ</td>
<td>10</td>
</tr>
<tr>
<td>Lock/unlock</td>
<td>PTZ</td>
<td>10</td>
</tr>
<tr>
<td>Flip position</td>
<td>PTZ</td>
<td>10</td>
</tr>
<tr>
<td>Control Iris</td>
<td>IRIS +/-</td>
<td>12</td>
</tr>
<tr>
<td>Focus</td>
<td>FOCUS +/-</td>
<td>13</td>
</tr>
<tr>
<td>Auxiliary controls ON</td>
<td>AUX Number → AUX</td>
<td>9</td>
</tr>
<tr>
<td>Auxiliary controls OFF</td>
<td>AUX Number → SHIFT → AUX</td>
<td>3+9</td>
</tr>
</tbody>
</table>

**Change Camera Mode**

Note: In order to utilize this function, there must be a video profile assigned the the camera. The Default timeout for these functions is 3 minutes at which time it will revert back to the *system picture* profile settings.

Supported only for FLIR CP-6302-31-I

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Command</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set night mode</td>
<td>6 → FN</td>
<td>6+5</td>
</tr>
<tr>
<td>Set Night mode with IR On</td>
<td>7 → FN</td>
<td>7+5</td>
</tr>
<tr>
<td>Set Day mode</td>
<td>8 → FN</td>
<td>8+5</td>
</tr>
<tr>
<td>Reset to current system picture profile</td>
<td>9 → FN</td>
<td>9+5</td>
</tr>
</tbody>
</table>

**DVT-KBD (Legacy)**
<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an analog monitor or ControlCenter viewing pane</td>
<td>Monitor number and MON</td>
</tr>
<tr>
<td>Select a viewing tile</td>
<td>Monitor number and MON</td>
</tr>
<tr>
<td>Display a camera on the selected monitor or tile</td>
<td>Camera number and CAM</td>
</tr>
<tr>
<td>Toggle through viewing pane layouts with 4-8 tiles</td>
<td>2x2</td>
</tr>
<tr>
<td>Toggle through viewing pane layouts with 9-13 tiles</td>
<td>3x3</td>
</tr>
<tr>
<td>Toggle through viewing pane layouts with 16 tiles</td>
<td>4x4</td>
</tr>
<tr>
<td>Expand currently selected tile to fill viewing pane</td>
<td>MON</td>
</tr>
<tr>
<td>Clear currently selected tile or analog monitor</td>
<td>CLEAR</td>
</tr>
<tr>
<td>Clear contents of the keyboard screen’s ENTER field</td>
<td>CLEAR</td>
</tr>
<tr>
<td>Display a sequence on the selected monitor or tile</td>
<td>Sequence number and SEQ</td>
</tr>
<tr>
<td>Display a sequence on the selected monitor or tile</td>
<td>Press SEQ twice</td>
</tr>
<tr>
<td>Hold a sequence</td>
<td>NEXT</td>
</tr>
<tr>
<td>Switch to the next camera of a paused sequence</td>
<td>LAST</td>
</tr>
<tr>
<td>Display an instant replay on the selected analog monitor (not available on a viewing tile when using the keyboard)</td>
<td>INST. REPLAY (See additional table for more instant replay controls)</td>
</tr>
<tr>
<td>Bookmark the selected file</td>
<td>BOOKMARK</td>
</tr>
<tr>
<td>Turn recording of the selected camera’s video stream on/off</td>
<td>RECORD ON/OFF</td>
</tr>
<tr>
<td>Trigger an alarm</td>
<td>Alarm number and ALARM</td>
</tr>
<tr>
<td>Acknowledge an alarm in its active tile</td>
<td>ACK</td>
</tr>
</tbody>
</table>

**Controlling Playbacks**

Following are the CCTV keyboard commands used to control playbacks:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>IRIS OPEN</td>
</tr>
<tr>
<td>Pause</td>
<td>IRIS CLOSE</td>
</tr>
</tbody>
</table>
Controlling PTZ Domes

Following are the CCTV keyboard commands used to control PTZ domes:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan left/right</td>
<td>Joystick left/right</td>
</tr>
<tr>
<td>Tilt up/down</td>
<td>Joystick up/down</td>
</tr>
<tr>
<td>Zoom in/out</td>
<td>Twist joystick clockwise/counter-clockwise</td>
</tr>
<tr>
<td>Call a dome preset</td>
<td>Preset number and PRESET</td>
</tr>
<tr>
<td>Call a dome pattern</td>
<td>Pattern number and PATTERN</td>
</tr>
<tr>
<td>Send a dome to its home position</td>
<td>HOME</td>
</tr>
<tr>
<td>Lock/unlock a dome</td>
<td>LOCK</td>
</tr>
<tr>
<td>Flip a dome’s position</td>
<td>FLIP</td>
</tr>
<tr>
<td>Control a dome’s iris</td>
<td>Press and hold IRIS OPEN or IRIS CLOSE</td>
</tr>
<tr>
<td>Focus a dome</td>
<td>Press and hold FOCUS FAR or FOCUS NEAR</td>
</tr>
<tr>
<td>Utilize a dome’s auxiliary controls</td>
<td>Aux number and AUX ON or AUX OFF</td>
</tr>
</tbody>
</table>

3.3.12.2 Controlling the ControlCenter via the PC Keyboard

Using the PC keyboard, you can control the ControlCenter application (local and remote) with extensive functionality and ease of use. Following are the supported PC keyboard commands.

Selecting Entities and Tiles by ID

All entities (cameras, camera sequences, tiles, layouts, monitors, etc.) have a unique ID represented by a logical number (xxxx). To apply a command to specific entities, they have to be entered after the entity ID. To help the user keep track of what number has been entered, all digit keystrokes ('0' through '9') are shown in the toolbar. The number displayed in the toolbar will be the ID used by the next keyboard command.

Note: The keypad NUM LOCK must be on for the following commands.

Following are the PC keyboard commands used to select entities and tiles by their IDs:
Function | Command
---|---
Select monitor or tile xxxx | xxxx and keypad ‘.’
The current monitor, tile and camera selections are all indicated in the toolbar.
Select camera or layout xxxx | xxxx and keypad ENTER
Select camera sequence xxxx | xxxx and CTRL and keypad ENTER
Select system (Latitude system) xxxx | xxxx and M
Clear led display | ESC

For example, to put a camera on a tile, type the following: <monitor ID>.<tile number>.<camera ID> ENTER

**Controlling the Selected Tile**
Following are the PC keyboard commands used to control the selected tile:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected tile - Arm/disarm toggle</td>
<td>A</td>
</tr>
<tr>
<td>Selected tile - Expand/collapse toggle</td>
<td>keypad ‘.’</td>
</tr>
<tr>
<td>Remove displayed entity</td>
<td>BACKSPACE</td>
</tr>
<tr>
<td>Camera - Add bookmark</td>
<td>B</td>
</tr>
<tr>
<td>Camera - Start/stop recording</td>
<td>R</td>
</tr>
<tr>
<td>Camera - Talk (push-to-talk)</td>
<td>, (comma)</td>
</tr>
<tr>
<td>Camera - Listen (on/off)</td>
<td>. (period)</td>
</tr>
<tr>
<td>Camera sequence - Start/stop</td>
<td>CTRL and Up arrow</td>
</tr>
<tr>
<td>Camera sequence - next camera</td>
<td>CTRL and Right arrow</td>
</tr>
<tr>
<td>Camera sequence - next camera</td>
<td>CTRL and Left arrow</td>
</tr>
</tbody>
</table>

**Controlling Alarms**
Following are the PC keyboard commands used to control alarms:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
</table>

December 8, 2020  Latitude, Horizon, Meridian Control Center Help File 49
Tools/Options Menu

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger alarm</td>
<td>xxxx and CTRL and A</td>
</tr>
<tr>
<td>Acknowledge alarm on selected tile</td>
<td>CTRL and Space</td>
</tr>
</tbody>
</table>

### Controlling Playbacks

Following are the PC keyboard commands used to control playbacks:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instant Replay on selected tile</td>
<td>I</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>G</td>
</tr>
<tr>
<td>Rewind</td>
<td>K</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>L</td>
</tr>
<tr>
<td>Increase playback speed</td>
<td>Shift and keypad ‘+’</td>
</tr>
<tr>
<td>Decrease playback speed</td>
<td>Shift and keypad ‘-’</td>
</tr>
</tbody>
</table>

### Controlling PTZ and Digital PTZ

Following are the PC keyboard commands used to control PTZs and digital PTZs:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan left</td>
<td>Shift and Left arrow</td>
</tr>
<tr>
<td>Pan right</td>
<td>Shift and Right arrow</td>
</tr>
<tr>
<td>Tilt up</td>
<td>Shift and Up arrow</td>
</tr>
<tr>
<td>Tilt down</td>
<td>Shift and Down arrow</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Shift and keypad ‘/’</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Shift and ‘*’</td>
</tr>
</tbody>
</table>

### Advanced PTZ Controls

Following are the PC keyboard commands used for advanced PTZ control:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decrease PTZ speed</td>
<td>Shift and keypad ‘-’</td>
</tr>
</tbody>
</table>
Increase PTZ speed
Shift and keypad ‘+’

Go to preset
xxxx and Shift and Insert

Set preset
xxxx and CTRL and Insert

Run pattern
xxxx and Shift and Home

Record pattern (start/stop)
xxxx and CTRL and Home

Auxiliary On
xxxx and Shift and Page up

Auxiliary Off
xxxx and Shift and Page up

Open iris
Shift and Delete

Close Iris
CTRL and Delete

Focus near
Shift and End

Focus far
CTRL and End

Lock
Shift and L

Go Home
Shift and H

Flip
Shift and F

Change Camera Mode
Note: In order to utilize this function, there must be a video profile assigned the the camera. The Default timeout for these functions is 3 minutes at which time it will revert back to the system picture profile settings

Supported only for FLIR CP-6302-31-I

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set night mode</td>
<td>F6</td>
</tr>
<tr>
<td>Set Night mode with IR On</td>
<td>F7</td>
</tr>
<tr>
<td>Set Day mode</td>
<td>F8</td>
</tr>
<tr>
<td>Reset to current system picture profile</td>
<td>F9</td>
</tr>
</tbody>
</table>

3.3.12.3 USB Joystick

USB joysticks can be connected to a client PC's USB port. Since the connection is local, the use of a joystick does not have an effect on privileges. Joysticks with Direct USB connections can be used in the ControlCenter.
A USB Joystick can be added and its settings can be configured by going to Tools -- Options and clicking the Joystick tab in the Options dialog box.

3.4 Favorites

Favorites allows the user to create and save additional custom workspace configurations to best suit his security environment and maximize operation efficiency.

Favorites

After customizing the ControlCenter to display the panes and tile layout of your choice, you can add the settings to your Favorites and access it at any stage by selecting it from the Favorites drop-down in the Application Menu.

To add a customized layout to your Favorites Mode

1. Create a mode by selecting the desired panes in your workspace.
2. Access the Favorites menu by clicking “Favorites” in the Application Menu at the top of the <% CONTROLCENTERNAME%> window.
3. Click 'Save layout as favorite'.
4. Type the desired name for your Favorite Mode.

To access a customized layout
1. Access the Favorites menu by clicking "Favorites" in the Application Menu at the top of the `<% CONTROLCENTERNAME%>` window
2. Expand the drop-down menu of the Favorites mode, and then select the desired layout.

![Favorites Menu]

To delete a customized layout
1. Access the Favorites menu by clicking "Favorites" in the Application Menu at the top of the `<% CONTROLCENTERNAME%>` window
2. Click "Manage Favorites"
3. Select the layout to be deleted
4. Click "Delete" on the upper left
5. Click "Save" to complete the delete action.
Favorites

Manage Favorites

Delete

Save  Cancel
4 Explorer Area - Navigation Pane

The Explorer Area is the navigation pane where the various features for finding and displaying into the Display area the content you want. Items selected can be seen and used in viewing panes and layouts. The following Explorer area content and features are covered in this section:

- Navigation Tree
- Query Pane
- PTZ Pane (Control Panel)

4.1 Navigation Tree

The Navigation Tree presents a hierarchical view of the system's logical entities (e.g. cameras, audio sources, etc.). It is most commonly used to start displaying live video or playing live audio within the application or via external output devices.

**Navigation Tree Entries**

The Navigation Tree contains all Sites (these can be expanded to show all logical entities within each Site) and all entities not allocated to specific Sites.

When the Latitude is connected to more than one System, the Site Filter can be used to display or hide selected Systems and Sites within those Systems.

**Note:** Sites and Entities displayed can be limited by the privileges associated with specific users or groups of users as set up by the system administrator.

The following display modes show information about the entities in the Navigation Tree:

- **Bold entries** refer to camera entities which are currently displayed in viewing tiles.
- Colored entries are used to show the status of Analytics-capable cameras:
Dual-Sensor Cameras in the Navigation Pane

Dual-Sensor cameras that are integrated into the system (such as the FLIR PT-Series) are shown as two entries in the Navigation Pane.

To display a camera, sequence or map scene on a tile: Drag and drop the scene onto a viewing tile or double-click it to display on the first unoccupied tile (or the Spot tile, if one is configured). If audio sources are associated with a camera, they will activate.

To display a camera, sequence or map scene on a monitor: Drag and drop the scene onto the desired analog monitor in the Navigation Tree. Audio streams linked to a camera utilize the audio input/output devices linked to the monitor if any are defined.

To play audio through the workstation's speakers: Drag and drop the speaker onto a Viewing Pane audio layout and use the audio tile’s controls to adjust volume and other parameters.

To transmit audio using a connected microphone: Drag and drop the microphone onto a Viewing Pane audio layout and click the microphone button to begin talking and transmitting.
Aside from the tree display, the Navigation Tree contains buttons at the top of the pane, as follows:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh Button" /></td>
<td>The refresh button can be clicked to manually refresh the Navigation Tree.</td>
</tr>
<tr>
<td><img src="image" alt="Filter Button" /></td>
<td>Clicking the filter button displays a drop-down list allowing users to toggle entity types to be visible or hidden. Settings in use are kept and restored when the same user logs in again.</td>
</tr>
<tr>
<td><img src="image" alt="Site Filter" /></td>
<td>The site filter opens up a window showing all defined sites in the system. The user can search and select/deselect the relevant sites they want displayed in the navigation tree at a given time.</td>
</tr>
<tr>
<td><img src="image" alt="Collapse All Button" /></td>
<td>The collapse all button will collapse all expanded tree entities</td>
</tr>
</tbody>
</table>

### Icon State Symbols

The state of an entity is sometimes reflected in the appearance of its icon as shown in entity trees throughout the system, including those in the Navigation Pane.

<table>
<thead>
<tr>
<th>Icon state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Recording Symbol" /></td>
<td>Entity being recorded.</td>
</tr>
<tr>
<td><img src="image" alt="Offline Symbol" /></td>
<td>Icon of Offline entities are shown grayed out.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Symbol" /></td>
<td>Entity is in a warning state</td>
</tr>
<tr>
<td><img src="image" alt="Disconnected Symbol" /></td>
<td>Disconnected entity</td>
</tr>
<tr>
<td><img src="image" alt="Microphone Symbol" /></td>
<td>Entity linked to a microphone</td>
</tr>
<tr>
<td><img src="image" alt="Abnormal Symbol" /></td>
<td>input/output pin device in an abnormal state.</td>
</tr>
<tr>
<td><img src="image" alt="Unknown Symbol" /></td>
<td>input/output pin device in an unknown state.</td>
</tr>
<tr>
<td><img src="image" alt="Failed Symbol" /></td>
<td>Archiver for this entity failed.</td>
</tr>
</tbody>
</table>

Multiple state symbols may be integrated into a single entity icon, as in the case of a recording camera linked to a microphone.

### Site Filter

When the Latitude is connected to more than one System, the Site Filter can be used to display or hide selected systems and sites within those Systems.
4.2 Query Pane

The Query Pane provides an easy-to-use interface for searching the system’s video and audio archives. It supports search based on date and time for clips, bookmarks, incidents and alarm. It is also used to launch playback.
Types of Query

All queries can be conditioned on camera/s (or other type or source), Text filter (opt), Date and Time. Depending on the type of Query, additional advanced parameters may be used.

The following Query types are supported:

<table>
<thead>
<tr>
<th>Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Can include parameters on how Alarm was triggered, etc.</td>
</tr>
<tr>
<td>Background Export Clip</td>
<td></td>
</tr>
<tr>
<td>Bookmark</td>
<td>Search for Bookmarks created manually in the timeline</td>
</tr>
<tr>
<td>Clip</td>
<td>Search for recorded clips</td>
</tr>
<tr>
<td>Incident</td>
<td>Search for incidents triggered by Actions defined in Admin Center</td>
</tr>
<tr>
<td>Motion Bookmark</td>
<td>Search for motion bookmarks display them in the Timeline in the Query Results pane</td>
</tr>
<tr>
<td>Motion Indication</td>
<td>Search for indicated detected motion in recorded video and display it in the Timeline in the Query Results pane</td>
</tr>
<tr>
<td>Smart Search</td>
<td>Search for motion in specific regions of recorded video</td>
</tr>
</tbody>
</table>
To search for Cleared Alarms (associated clips):

1. To assure a default search, click on the bottom right

2. To define additional parameters for an advanced search, click and do the following in the Additional clip parameters dialog that appears.
   From the Initiated by tree, select one or more users. Note that auto-cleared alarms have no user defined. If you want to return auto-cleared alarms, you cannot select any users.
   a. In the Alarm description field, type text that must match in the Alarm description.
   b. To search only redundant Archivers, select Search redundant Archivers.

Note: Only available when connected to a `<%HOSTSYSTEM%>` system
   Note: If enabled the primary Archiver will not be searched.
   c. Click OK.

4. From the Search for menu, select Alarm.

5. Select the recorded source scene, by marking the tree entities.

6. From the Date and Time menu, select a preset time option
   -or-
   Select Manual selection and then enter From date and time and To date and time.

7. In the Text search, type optional text to find in the Alarm Name.

8. Click Search.

9. To view the associated clip segments of an Alarm (if defined with alarm type) in the Query Results pane, expand the Alarm by clicking on the (+) and then double click the video you want to view.

To reset your query parameters, click the Reset button.

To search for Bookmarks (with related clip segments):

1. In the Query pane from the Search for menu, select Bookmark.

2. Click and do the following in the Additional clip parameters dialog that appears.
   a. From the Initiated by tree, select one or more users.
   b. On `<%HOSTSYSTEM%>` systems, an additional check-box is shown:
      To search only redundant archivers, select Search redundant Archivers.
      Note: If enabled the primary Archiver will not be searched.
   c. Click OK.

3. Select the recorded source scene, by marking the tree entities.

4. In the Text search, type optional text to find in the Bookmark Name.

5. From the Date and Time menu, select a preset time option or select Manual selection and then enter From date and time and To date and time.

6. Click Search.
   The returned results display in the Query Results pane.

7. To view the associated clip segment of a bookmark in the Timeline playback, in the Query Results pane, double click the bookmark you want to view.
To do a simple search for a Clip (Clips that satisfy the search are listed in Query Results):

1. From the Search for menu, select Clip.

2. To reset Query parameters and return to a default search, click 🔍

3. Select the recorded source scene, by marking the tree entities.

4. From the Date and Time menu, select a preset time option
   -or-
   Select Manual selection and then enter From date and time and To date and time.

5. Click Search.

To do a simple search for a Clip (Synchronized Playback):

1. To reset Query parameters and return to a default search, click 🔍

2. From the Search for menu, select Clip.

3. Select scenes for recorded source scenes, by marking the tree entities. You can select from one up to the maximum number of scenes as defined in the to the maximum as defined in the Tools ► Options ► Video ► Playback screen settings. The default is six maximum.

4. From the Date and Time menu, select a preset time option
   -or-
   Select Manual selection and then enter From date and time and To date and time.

5. Click Sync.
   The clips found by the search load into the Timeline - Synchronized Playback Layout.

6. Once the sync playback layout is opened, the User will be able to drag to open scenes from the main camera tree.
   a. When a scene is dragged into an empty tile, it will be automatically synced with the other scenes in the layout. The unified Timeline will be updated to include the new scene.
   b. If the scene is dropped into a populated tile, it will open the new scene in the next available tile. If no tile is available, the layout will be automatically modified to include more tiles.
   c. Scenes with linked audio will take two tiles, which will also expand the layout if necessary.

7. Scenes can also be dragged out of the layout to remove them and the unified timeline will be removed for that scene.

Note: One scene (the "original" scene in the top left tile) must always remain in the Sync Playback layout in order to keep the playback times.

To do an advanced search for a Clip:

1. From the Search for menu, select Clip.

2. Click 🔍 and do the following in the Additional clip parameters dialog that appears.
a. From the Initiated by tree, select one or more users.
b. Click the Archiving triggers menu and in the Archiving trigger options list, mark or deselect the triggers to search for. Click the menu arrow again.
c. From the Protection status menu, select Locked for only locked clips, Unlocked for clips that are not locked, or Both for all clips.
d. To enable or disable the optional display of motion preview on the clip in the Timeline pane, select or deselect Show motion preview.
e. On <%HOSTSYSTEM%> systems, an additional check-box is shown:
   To search only redundant Archivers, select Search redundant Archivers.
   Note: If enabled, the primary Archiver will not be searched.

**Note: Only available when connected to a <%HOSTSYSTEM%> system**

f. Click OK.

4. Select the recorded source scene by marking the tree entities.
   If you are want to display found clips in Query Results pane, select one or more.
   If you want to display found clip results in a Synchronized Playback, select clips
   Note: The maximum no. of clips that may be defined is set in the Tools►Options►Video►Playback screen.

5. From the Date and Time menu, select a preset time option
   -or-
   Select Manual selection and then enter From date and time and To date and time.

6. In the Text search, type optional text to find in the Clip Name.

7. Do the following:
   a. For listing found clips in the Query Results pane, click Search.
   b. For automatically playing found clips in Timeline and in a Synchronized Playback, click Sync.

   Note: Changes remain in effect until reset. If the changes made are only for this search or you want to reset them, click [reset button].

   ! Warning: Query results are displayed time ascending. When the query results exceed the limit that is specified by the query, only partial results are returned. Change the time filter to include the required time span in the query.

**To search for Incidents (with all related bookmarks with clip segments):**
1. In the Query pane from the Search for menu, select Incidents.

2. Click and do the following in the Additional clip parameters dialog that appears.
   a. From the Initiated by tree, select one or more users
   b. To search only redundant Archivers, select Search redundant Archivers. Note: If enabled the primary Archiver will not be searched
   c. Click OK.

4. Select the recorded source scene, by marking the tree entities.

5. In the Text search, type optional text to find in the Incident Name.

6. From the Date and Time menu, select a preset time option or select Manual selection and then enter From date and time and To date and time.

For a list of results in the Query Results pane.
   a. Click Search to start the query.
   b. Click Stop when you wish to end the query.

The query results appear in the Query Results pane.

7. To view the associated bookmarks and clip segments of a Incident in the Timeline playback, in the Query Results pane, expand the incident by clicking on the (+) and then double click the bookmark you want to view.

Query results are displayed time ascending. When the query results exceed the limit that is specified by the query, only partial results are returned. Change the time filter to include the desired time span in the query.

For a list of results in the Thumbnail search format.
   a. Click Thumbnails
   b. A Thumbnail search layout will open. The results will appear in chronological order of all cameras selected.

**Motion Bookmark**

Using Motion Bookmark, you can search for motion bookmarks in recorded scenes and see if any motion occurred during a specified time. The results will appear in the timeline of the **Query Results** pane.

**To Use Motion Bookmark:**

2. From the Motion Query Type drop-down list, select Motion Bookmark.

3. In the Select Scene drop-down list, select the check box of the scenes you would like to search (you can select a logical location, such as a site, to search all applicable scenes in the location).
4. From the Date and Time menu, select a preset time option
   -or-
   Select Manual selection and then enter From date and time and To date and time.

5. If required, click and select the Search redundant Archivers check box.

**Note: Only available when connected to a Latitude system**

**For a list of results in the Query Results pane.**
   a. Click Search to start the query.
   b. Click Stop when you wish to end the query.

The query results appear in the Query Results pane.

**For a list of results in the Thumbnail search format.**
   a. Click Thumbnails
   b. A Thumbnail search layout will open. The results will appear in chronological order of all cameras selected.

---

**Motion Indication**

Using Motion Indication, you can search for motion in recorded scenes and see if any motion occurred during a specified time. The results will appear in the timeline of the Query Results pane.

**To Use Motion Indication:**

1. From the Motion Query Type drop-down list, select Motion Indication.
2. In the Select Scene drop-down list, select the check box of the scenes you would like to search (you can select a logical location, such as a site, to search all applicable scenes in the location).
3. From the Date and Time menu, select a preset time option
   -or-
   Select Manual selection and then enter From date and time and To date and time.
4. Click Preview.
5. In the Search Parameters pane, set the required level of motion indication using the slider.
6. If required, select the Search redundant Archivers check box.
7. Click Search to start the query.
8. Click Stop when you wish to end the query.

The query results appear in the Query Results pane.
Smart Search
Using Smart Search, you can select an area of interest and search if any motion occurred during a specified time in recorded scenes.
It is possible to run multiple searches concurrently.

To perform a Smart Search:
1. From the Search drop-down list, select Smart Search.
2. In the query camera tree, select the scene you would like to search (you can only select one scene at a time).
3. From the Date and Time menu, select a preset time option e.g. 24 hours
   -or-
   Select Manual selection from the bottom of the menu and then enter From date and time and To date and time.
4. Click Setup Smart Search to bring up the Smart Search configuration window.
   Note: You can disable Privacy Mask that is displayed by Right-clicking and selecting Deactivate privacy mask.
5. Select the specific area in which you want to query motion by using the icons described in the table below (it will appear as a green layer).
   Note: You can disable Privacy Mask that is displayed by right-clicking on the image and selecting Deactivate privacy mask (dependent on user permissions).
Click this button to mark a rectangle-shaped area as area of interest. In the Preview screen, mark the desired area.

Click this button to mark the whole screen as area of interest.

Click this button to erase single macro blocks from a previously marked area of interest. In the Preview screen, erase the macro blocks to be taken out of the desired area.

Click this button to mark single macro blocks as area of interest. In the Preview screen, mark the desired area.

Click this button to clear the whole screen.

Right after the zone of interest is defined, motion is displayed (green layer) in the Preview pane.

6. In the Query Type Parameters section, the default Smart Search parameters appear. You can change the following parameters:

- **Threshold** - The threshold which, when passed, the state alternates to Motion on, i.e. when motion is detected.
- **Consecutive Frame Hit** - The number of consecutive frames which should pass the motion on threshold in order to alternate the state to Motion on
- Accuracy/Speed - Select the required level of accuracy as opposed to speed using the slider.
7. Select the Search redundant Archivers check box if required.
8. Click Search to start the Smart Search. The search may take a while. The query results gradually appear in the Query Results pane.
9. Click Stop when you want to end the query. After clicking stop, the results that were found up to that point are displayed in the Query Results pane.
10. Double-click or drag the required results to the tiles to play them.
   When the results are played, the timeline changes from green to red whenever motion is detected.

**To perform a thumbnail search**

Selecting ‘Thumbnail Search provides a visual way of browsing through recorded content.
1. Set up the Query.
   a. Select only ONE camera in the Query pane Navigation Tree
   b. Set Date and Time parameters.
   c. Set Interval. (Thumbnails will commence from the Start Time, and be displayed at the selected Interval.)
2. On pressing Search, the Viewing Pane displays a new Thumbnail Search Layout, with the recorded material from the selected source, with the set of associated Thumbnails.

**To use digital zoom within thumbnail search:**

1. Click the magnifying glass on the bottom right of the video.
2. Select the area to magnify.

   Thumbnails are displayed.

**Note:** For clarity, maximize the video prior to performing the digital zoom.
4.3 PTZ Pane

PTZ stands for Pan, Tilt, and Zoom

This term previously applied only to a camera with a motorized mount able to rotate to pan left and right, tilt up and down, and use motorized lens magnification to zoom in and out on the scene.

With the high resolution offered by modern cameras, PTZ capabilities within the image from a fixed camera are also provided, allowing the user to zoom in and then digital pan, tilt and zoom.

This capability is further extended by allowing the user viewing the image from a PTZ camera to choose a view, and then use Digital PTZ facilities within the selected scene.

(See Digital PTZ, below)

The PTZ Pane for the selected camera is displayed below the Navigation Pane in the Control Center.
Zoom mode - Click to change from Optical to Digital (only for PTZ cameras)

Notes:
1. Fixed cameras do not offer Optical Zoom Mode, and Presets are disabled.
2. On PTZ cameras, when returning to Optical Mode from Digital, the camera is reset to the current Optical view.

To move the camera: Use the directional buttons.
PTZ Pane

To zoom in and out: Click the + and - buttons, respectively.
To move the camera to its home position: Click the button.
To flip the camera: Click the button.
To lock the camera: Click the button.

The Preset area of the PTZ Control Panel allows you to the following functions:
- **PTZ control**: When a PTZ camera type is selected, the camera can be controlled directly
- **Preset Selection**: Clicking on a selection button moves the camera to show the preset view associated with that button.
- **Preset Settings**: This area allows each preset to be named (Edit), and stored (Set). The camera’s pan, tilt, and zoom settings will be stored. Allows one preset defined for each numbered load button.
- **Aux Mode**: When an auxiliary, PT or PTZ auxiliary device is selected, much like standard PTZ presets, the aux mode allows preset of a pan tilt and zoom stored to memory. It is for devices that work on the same principles as a PTZ camera. (e.g. a PT motor or servo). This allows one preset defined for each numbered button.
- **To move the camera to a preset**: Click the corresponding button.
- **To adjust the Iris, Speed and Focus settings**: Use their respective + and - buttons.

Digital PTZ Capability

Digital PTZ using a fixed Camera
The system provides a digital PTZ capability on fixed cameras. By zooming in on the initial picture (using the + symbol in the PTZ control), the system provides a virtual zoom into the scene. Then, the user can use the PTZ controls to move the display to a particular area.

Using Digital PTZ mode on a regular PTZ camera
When using a regular PTZ camera, the user can select a view using the standard PTZ controls, and then change to Digital PTZ mode in one of two ways:
1. Right-click in the PTZ camera pane and select 'Switch to Digital PTZ' from the context menu
or
2. Click on the button 'Optical' in the PTZ pane
Using either method, the scene will then allow the user to use the Digital Zoom capability within the scene.

Canceling Digital PTZ mode
Digital PTZ mode is canceled either by clicking the Optical/Digital button in the PTZ pane (The button is set to 'Digital' when in that mode), or by again right-clicking in the PTZ camera viewing pane, and selecting 'Switch to Optical PTZ' from the context menu.

Additional PTZ capability
Once viewing an image in the viewing tile, the system provides additional magnification and movement around the magnified tile image **using the mouse**.
- **Scene Tracker Mode**:
Note: Only available when connected to a Latitude system
When a defined Scene Tracker view is selected, it works like a digital version of a pan, tilt and zoom preset that remembers what viewed area of the composite Scene Tracker view was loaded when the preset was defined. Allows one preset defined for each numbered load button.

4.4 CaseBuilder Query Pane

Note: Only available when connected to a `<%HOSTSYSTEM%>` system
The CaseBuilder Query Pane allows you to search the CaseBuilder server database and Data Location Path for saved cases. (To see more about how cases are created and updated, see Cases - CaseBuilder Features.)

The features of the CaseBuilder Query pane allow targeted searches using a variety of filters and matching options.

The following fields are available in the CaseBuilder Query Pane:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Name:</td>
<td></td>
</tr>
<tr>
<td>Serial Number:</td>
<td></td>
</tr>
<tr>
<td>Created by:</td>
<td></td>
</tr>
<tr>
<td>Start Time:</td>
<td>End Time:</td>
</tr>
<tr>
<td>Creation Time:</td>
<td></td>
</tr>
</tbody>
</table>

*CaseBuilder Query Pane - Simple*  
*CaseBuilder Query Pane - Advanced*
CaseBuilder Query Pane

<table>
<thead>
<tr>
<th><strong>Case Name</strong></th>
<th>Search for any case with a Case Name that matches the entered text (Full or partial).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Serial Number</strong></td>
<td>Find a specific Case Number (Case Numbers are allocated automatically by the system when Cases are first created)</td>
</tr>
<tr>
<td><strong>Created by</strong></td>
<td>Drop-down opens list of Users. Checking one or more users in the list will limit the search to cases created by that/those users.</td>
</tr>
<tr>
<td><strong>Case Time</strong></td>
<td>Limit the query to cases that were created between the start time/date and the end time/date.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Search for cases where the 'long' description contains the specified text.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Opens the Advanced search options dialog that allows the specification of advanced search parameters</td>
</tr>
<tr>
<td><strong>Go</strong></td>
<td>Initiates the search according to the settings and returns any results in the Query Results pane.</td>
</tr>
</tbody>
</table>

Cases matching the criteria in the CaseBuilder Query Pane are listed in the Query Results pane.

Results of a CaseBuilder Query appear in the Query Results pane.

Selecting a Case from the Query window opens that case, with the CaseBuilder Navigation tab showing all the materials that have been added to the selected Case, and a dedicated CaseBuilder Layout tab.

Selecting a bookmark, clip or incident from the CaseBuilder Navigation tree will open the selected item in the Case Builder Layout. The Timeline shows the playing position of a retrieved item.

See CaseBuilder Navigation Tree Pane

4.4.1 CaseBuilder Navigation Tree Pane

**Note: Only available when connected to a <%HOSTSYSTEM%> system**

The CaseBuilder mode is selected from the Side-Bar. This opens up the CaseBuilder Layout in the display area and the CaseBuilder Navigation Tree displays in the Explorer area.

This Navigation Tree contains the CaseBuilder Toolbar as well as a tree for viewing and selecting the elements added and configured in the open case.

**Note:** The Case Builder Navigation tree is not used for browsing the available cases - it shows only the details of an open case.

Case Builder Navigation Tree Toolbar Icons
The following table shows the CaseBuilder Navigation Tree Toolbar icons and features:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>New Case</td>
<td>Adds a new case to the CaseBuilder Navigation Tree for adding and saving material to.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Open Exported Case</td>
<td>Opens a dialog for selecting an exported case file to load into the CaseBuilder Navigation Tree and Layout. This is not for opening saved cases in the default CaseBuilder directory. To open a saved case, you must use the CaseBuilder Query and select it from the Query Results pane.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Add</td>
<td>Menu for selecting to add a file or URL. File: (add file)Opens a dialog for browsing and selecting a file to add to the case. URL: (add URL) Opens a dialog for entering a URL (path) to browser for compatible content to be linked to the case.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Save</td>
<td>Saves the case and any changes to the CaseBuilder centralized default location on the network.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Delete</td>
<td>Removes the selected item in the CaseBuilder Navigation Tree from the case.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>Export</td>
<td>Opens a dialog for exporting the case and any supporting content to the location specified. If the CaseBuilder Options are set to export an included Player, exports folder and a zip file. If no player is included, exports a zip file only. Notes: 1. The Export icon is only enabled after the Case has been saved. 2. If a Privacy Mask is configured on the clips and the exported file user will need to disable the Privacy Mask during viewing, you will need to provide the user with the correct historical password. For more information, see Privacy Mask Password.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>Undo</td>
<td>Reloads the last saved case in the CaseBuilder Navigation Tree</td>
</tr>
</tbody>
</table>

The CaseBuilder Navigation Tree provides nodes for items added. By selecting these nodes, properties for the item load into the CaseBuilder Layout Case Properties area and can be modified and saved. The CaseBuilder Layout pane shows the contents of any item selected in the CaseBuilder Navigation Tree Pane.
The CaseBuilder Navigation Tree displaying the items and sub components added to a case, with one Case clip open.

By double clicking on attached files, the ControlCenter will call the default file system program for the file extension specified to run. For example, a file with a .exe extension is added to a case, double clicking on the file in the CaseBuilder Navigation Tree will run the executable file. If the file is a image .JPG file, the file system configured image program for that file extension will open and display the file. The exception is web browser .HTML files. These will open in the layout viewing widow.

4.5 Privacy Mask Password

When content that contains a Privacy Mask is exported, it may be necessary to retrieve the original password in order to remove the privacy mask.

Privacy Mask Password Export Behaviors (Historical vs. Current)

The Privacy Mask password behavior changes depending on the manner you export. Because the Privacy Mask password can be changed yet remains historically attached to video clips when they are recorded, the behavior under the following export types are as follows:

<table>
<thead>
<tr>
<th>Where</th>
<th>Type</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>When exporting clip from the <strong>Query Results</strong> or <strong>Timeline</strong></td>
<td>Create Clip - use Source video and apply <strong>current</strong></td>
<td>The Privacy Mask password attached to the exported DVT file is the current system-wide Privacy Mask Password</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>When execution of a <strong>Background Export</strong> occurs.</td>
<td>Copy Clip from Archiver - <strong>Historical</strong> static</td>
<td>The export assumes the clips are being moved to an insecure status. For each clip segment (single Archiver container), the Privacy Mask Password set at the time the clip was recorded (not exported) is enabled</td>
</tr>
<tr>
<td>When exporting a <strong>CaseBuilder</strong> case with clips</td>
<td>Copy Clip from Archiver - <strong>Historical</strong> static</td>
<td>The clips exported are for portable external use. The Privacy Mask Password for each clip segment (single Archiver container) set at the time the clip was recorded (not exported) is enabled</td>
</tr>
<tr>
<td>When execution of a <strong>Mass Export</strong> occurs.</td>
<td>Copy Clip from Archiver - <strong>Historical</strong> static</td>
<td>The export assumes the clips are being moved to an insecure status. For each clip segment (single Archiver container), the Privacy Mask Password set at the time the clip was recorded (not exported) is enabled</td>
</tr>
</tbody>
</table>

**Privacy Mask Password Export Rules - Current or Historical**

**CAUTION:** When exporting, the password used is not always the system-wide Privacy Mask Password at the time of export.

This section addresses only the ability of a user to *remove* the privacy mask while viewing an exported video clip. Users who simply want to view the files with the mask on the video clip will not be affected as there is no need to enter a password to view the clips with the privacy mask on.

When exporting a clip of video that has Privacy Mask configured on the video, the file immediately gets password protected against disabling the Privacy Mask. This password has no relation to the ControlCenter user password or permissions.

If you have changed your password within the period of the exported file range, how you export those files will determine the password mechanism employed.

Export either the **Current** Privacy Mask Password or the **Historical** Privacy Mask Password at the time the file was recorded.

The **Historical** password for each of the files remembers the password from that time. Thus if a range of files is being exported a Historical mechanism will make each file password protected for its point in time. Depending on the number of Privacy Mask password changes that have occurred, there may be as many different passwords required to Deactivate Privacy Masking. This is because the Password is embedded in the clips being recorded during the time when the password was active.

The Privacy Mask Password is stored in the recordings made by the Archiver from the video stream of the camera. Each of these is stored in a container according to your system settings. By default the file size in this container is 80mb. When a Privacy Mask Password is changed, the new password is applied at the
time the file is closed and written to the Archiver container. Thus, the password covers some video that was being buffered for recording before the file closed:

The Archiver Privacy Mask validation process for internal ControlCenter users is done via the user permissions of the `<%HOSTSYSTEM%>` system. The data of the of the Privacy Mask Password for future offline use is kept in the clips of the containers. In the diagram above this is represented by the yellow, blue and purple data core. In the color representations of different passwords in the graphic, you can see how the password changes in real-time with the live stream. The passwords changes in the middle of a clip not fully written to a file, are embedded in the recorded video from the start of the clip.

As of yet the three different embedded Privacy Mask passwords are not required for hiding or showing the Privacy mask for online users. It is when the recorded files are moved out of the Archiver storage that the Privacy Mask Password is implemented.

**Privacy Mask Password - "Current" password behavior**

When Exporting from a Results Query or Timeline the same video that is in the Archiver is exported with a single file Privacy Mask password whether it is the full clip or a partial. Additionally only the selected times are exported and no matter how large the clip is, it will be exported into as many files as needed based on the max size setting in the Export settings.
When Exporting from the Query Results or the Timeline pane where you can select entire clips or set video range in and out points for taking a segment. In this type of export, the embedded historical passwords are ignored and the current Privacy Mask password is used for every file created by exporting. In the example diagram that follows, two exports are represented. (one of a range and the other of the entire selected file). Only the password defined in the system advanced settings at the time of the export is applied even though the clip spans several Historical passwords. The password “ABC123” (colored purple) is used for all files exported from the Query Results or the Timeline pane export features.
Privacy Mask Password - "Historical" password behavior

In the following example a different mechanism is used to export. In this instance the files are directly copied from the Archiver container storage as-is and the historical passwords as imbedded are simply enabled on the files being copied outside the security zone of the Archiver.

In the above instance, each file if viewed independently and the user chooses to disable the Privacy Mask, the password they will be required to enter will be the password of the clip. Thus of the five clips, the first clip requires the password 1234, the second and third clip requires the password Old#7 and the fourth and fifth requires the password ABC123.

Because the clips are all from the same source, if they are viewed in a timeline together, only the most recent password is needed for disabling the mask of both clips.
Likewise the export of clips from the CaseBuilder has the same behavior as the Mass Export, in that it copies with the password files as-is from the Archiver. Thus if the password has changed, the selection of clips will influence what password is embedded from the historical Archiver data.

Additionally, the export file size is based one-to-one with the Archiver container files. Even if the range of the clip is limited, the file size will match the container sizes of the range and not the specific in and out points of the range.

CASEBUILDER EXPORT CASE (Range 4:02pm-4:16pm)

PW: 1234
PW: Old#7
PW: Old#7

80MB 80MB 80MB

In the above example, the segments of the DVT export file that are not specified in the range, will not be viewable to the end-user. The viewing of the clip in a timeline with a disabled privacy mask can be done by selecting the clip and entering the latest historical password. In this case “Old#7”.
5 Display Area - Viewing Pane

The Viewing Pane is used to view live and recorded video, maps and web pages, respond to alarms and to listen to and transmit audio. It consists of a viewing area made up of video tiles in the center, a toolbar on the right, and layout tabs at the top.

The following sections present detailed descriptions of these areas of the pane.

- Viewing Tile
- Layout Tabs

5.1 Layout Tabs

The Viewing Pane's layout tabs allow users to easily switch between layouts. The tabs appear automatically when layouts are opened.

Layouts are the only types of entities that are created and configured via <ControlCenter> rather than <% ADMINCENTERNAME%>.

A tile layout consists of a tile pattern, content (the entities displayed on the tiles), arming states, and digital presets (when in use).
To configure a tile layout

1. From the Viewing Pane Toolbar,

   Click the **Layout** icon to open the **Layout dialog**.

2. Click **Add Layout**

   ![Add Layout](image)

   **Single system - Add**

   **Multiple Systems - specify in which the Layout will be saved**

3. Enter a name for the new Layout.

4. **Save** the new Layout.

To Customize a layout

1. From a blank layout (or an existing one if you want to overwrite it)
   
   a. Choose a tile pattern by opening the **Layout dialog** (see above) and clicking one of the tile pattern buttons.
   
   b. Drag and drop cameras, sequences and maps from the Navigation Pane onto viewing tiles.
   
   c. If you wish to use Digital Presets, select them by using the in-pane controls (Right click and select **Go to Preset**) or use the PTZ pane to select a Digital Preset for the current viewing tile.
   
   d. Arm viewing tiles for alternative content or alarms as applicable.

2. When the Layout contains the required components, click the **Save Layout** option on the **Layout dialog**.

The available layouts are displayed in the Navigation tree:
In the Viewing Pane, pressing the **Close icon** at the right of the **layout tab strip** will clear the currently active Layout.

### 5.2 Configuring Layouts

A tile layout consists of a tile pattern, content (the entities displayed on the tiles), arming states, and **digital presets** (when in use). (Audio layouts are associated only with content)

**To configure a tile layout:**

1. Switch to the layout that you would like to modify by clicking its tab at the top of the Viewing Pane or double clicking its icon in the Navigation Pane (use Default Layout 101 if none others exist).
2. Click the "Layout Pattern Menu" to the top-right of the viewing pane.
3. Choose a tile pattern by clicking one of the tile pattern buttons in the Layout Menu drop down.
4. Drag and drop cameras, sequences and maps from the Navigation Pane onto viewing tiles.
5. If you wish to use Digital Presets, select them by using the in-pane controls (Right click and select Go to Preset) or use the PTZ pane to select a Digital Preset for the current viewing tile.
6. Arm viewing tiles for alternative content or alarms as applicable.
7. In the Layout Pattern Menu, click 'Save Layout' to save your layout.
5.2.1 Thumbnail Search Layout

Each time the Thumbnail Search option is used as a Query Type in the Query pane, the Thumbnail Search Layout is opened, showing a set of thumbnail images from recordings available during the ‘From:’ and ‘To:’ times in the Date and Time settings.

Using Thumbnail Search is briefly described below.

5.2.2 CaseBuilder Layout

The CaseBuilder Layout is different from Default Layouts and Audio Layouts, as it serves a specialized task of helping a user build cases and configure information that will be used for research and investigative purposes. Additionally it allows users to review and display the materials after the case is completed and exported.

The layout displays properties for the case and components of the case based on the selection made in the CaseBuilder Navigation Tree.

Where the other layouts are tied to the Archiver server only, the CaseBuilder Layout requires the CaseBuilder Server is accessible when working with a server side case but can work offline when viewing an offline exported case.

In order to view, a server case, the CaseBuilder Query must be run and a case must be selected and opened. At start up, no case or items are displayed in the layout.

The CaseBuilder Layout is divided into two sections:

- **Properties Area** and **Viewing Window**
The Properties may contain settings that cannot be changed. When viewing a new or saved case there may be some values that are inherent to the selected entity that are not permitted to be change.

When viewing exported cases, it is considered a static case at the time of export. If the exported case is out of date or incorrect, the CaseBuilder user who generated will need to modify the source and regenerate it.

The Viewing Window allows the viewing of video clips that are either opened by double clicking on the video clip (or bookmark) in the CaseBuilder Navigation Tree or by dragging and dropping video from clips in the Query Results.

Additionally the Viewing Window supports viewing of HTML content from URLs as well as snapshots that have been added to a case and are shown in the CaseBuilder Navigation Tree.
The Viewing Window also works with Privacy Masking and allows a user with the password to remove the privacy mask from Archiver recorded clips. Once a case is exported with a privacy mask, the Privacy Mask Password (or passwords) from that timeline must be used to remove the privacy mask. For more information, see Privacy Mask Password Export Rules – Historical.

5.3 Viewing Tile

The viewing tile contains a viewing area and a toolbar. Where possible, Adaptive Streaming automatically selects the best video stream resolution to enhance performance and save bandwidth.

When the Maintain Aspect Ratio setting in Options/Tools is set, then if the aspect ratios of the video frame and viewing are unequal, horizontal or vertical bars fill the unused parts of the tile. The user can change the Aspect Ratio setting for a selected tile by clicking Shift-R.

The toolbar and On-screen display are configurable.

**Viewing Tile Features**

- On Screen Display
- Digital Zoom
- Digital Presets
- Dual Sensor Camera
- Viewing Tile Toolbar
- Armed Tiles
- Toggle Privacy Mask
- Spot Monitor
- Viewing Live and Recorded Video from connected DVRs

The border of a tile's viewing area provides important information about the tile's state:

<table>
<thead>
<tr>
<th>Color</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The tile is **focused**. You must focus a tile in order to expand it to fill the viewing pane or to use digital zoom or PTZ controls on its video content. Only one tile can be focused at any given time. A tile turns focused when it is clicked or when new *unarmed* content is dropped onto it.

The border of a tile’s viewing area turns blinking red when content *for which it has been armed* begins playing. The border disappears as soon as the tile is clicked. Multiple tiles can have red borders at the same time.

Normal tile - no specific status.

The tile is **selected**. A focused tile becomes selected when *another* tile is control-clicked (thus becoming focused itself). Selection is only meaningful, therefore, when trying to apply an action to multiple tiles. The most common uses for this is when bookmarking or trashing multiple tiles at the same time.

An important feature of the viewing tile is that it can be configured to be multi-layered. When a scene is displayed on a non-empty tile, it “covers” the tile’s former content but does not remove it. When the scene is removed, the previously hidden content on the now-top layer is shown again.

**On Screen Display (OSD)**

It is possible to display relevant information on the screen, such as the scene name, status description, status image, video statistics and time.

Using the [Tools - Options Menu](#), you can now set the font and background parameters of the information displayed on screen and determine what information is displayed.

**Note:** Any changes made to the On Screen Display only apply to tile content that is dragged to the Viewing pane after the configuration, and not to the content already displayed in the Viewing pane.

**Digital Zoom**

Two methods are available:
**Zoom the Viewing Tile - Draw to Zoom**

For fixed cameras, a Magnify icon is provided, which allows the user to use the mouse to draw a rectangle around the area to be viewed.

After clicking the Magnify icon, use the mouse to click-and-drag the area you wish to magnify. The selected area is displayed.

To return the tile to normal display, right-click to open the Context menu, and select **Reset digital zoom**.

**Zoom the Viewing Tile - Manual Control**

When using a mouse which has a scroll-wheel, you can control digital and optical PTZ functionality directly from the tile.

**To enter/exit PTZ control mode:** Click the scroll-wheel while the mouse is over the tile. Depending on the mouse's location in the tile, the cursor will turn into one of eight directional green arrows.

**To pan or tilt:** Move the mouse so that the cursor points in the direction in which you would like to move the camera in and click the left mouse. The speed of the movement is...
proportional to the distance from the of the cursor from the middle of the tile.

**To zoom in:** Scroll upwards with the scroll-wheel, to zoom out, scroll down with the scroll-wheel.

*Figure: A video tile digitally zoomed*

**Digital Pan**

When in digital zoom the tile displays orange directional arrows as the mouse pointer icon. These arrows shift as you move the mouse around the image to indicate the move direction that will occur if the mouse is clicked. When clicked, the move will small if the cursor is nearer to the center of the tile, greater if it is closer to the edges.

While in Digital Move mode, a small Zoo window indicates the current state - i.e. showing the current size and location of the displayed area relative to the total camera field of view.

*Figure: Digital zoom pan (move) icons*

**Navigating on a Digitally-zoomed Tile:**

- **To move up** (towards the top of the image): Move the mouse pointer to the central upper part of the magnified video tile so that the green cursor arrow points up and then click the mouse.

- **To move down** (towards the bottom of the image): Move the mouse pointer to the central lower part of the magnified video tile so that the green cursor arrow points down and then click the mouse.

- **To pan right:** Move the mouse pointer to the central right edge of the magnified video tile so that the green cursor arrow points right and then click the mouse.

- **To pan left:** Move the mouse pointer to the central left edge of the magnified video tile so that the green cursor arrow points left and then click.

- **To move diagonally:** Move the mouse pointer to the corner edge (upper-right, upper-left, lower-right, lower-left) of the magnified video tile so that the green cursor arrow points in the diagonal angle you want to go and then click the mouse.

- Restoring the video image to full size centered image can be done using the Reset digital zoom menu option.

**To remove digital magnification (zoom) from a tile**
On the ControlCenter tile, right mouse-click the magnified video image in the select Reset digital zoom from the shortcut menu.

**Dual Sensor Camera Picture-in-Picture (PIP) Display**

When viewing output from a Dual Sensor Thermal/Visible camera that has been integrated with <\% HOSTSYSTEM\%>, such as the FLIR PT Series, the viewing tile presents a Picture-in-Picture (PIP) view of the Thermal and Visible scenes.

Both cameras appear in the Navigation Pane.

Both Images are shown in the Viewing Pane. The Primary image (Full tile) is shown highlighted in the Navigation Tree.

**Visible Image Primary**  
**Thermal Image Primary**

_Dual Sensor Thermal/Visible Camera_
Using the Picture-in-Picture display

The user can switch between viewing the Visible or Thermal images as primary by double-clicking in the viewing tile's Picture-in-Picture window. Double-clicking in the main window of the Viewing tile makes the viewing tile full-screen, as for any other viewing tile.

When the mouse is inside the Picture-in-Picture window, the user has two additional controls:

- To **minimize** the P-i-P window, click the **Minimize icon**.
- (To re-open the P-i-P window, click on the **P-i-P icon** that appears in the margin when the image has been minimized.)
- To **re-size** the P-i-P window, drag the **Re-size icon**.

Viewing an EST-Enabled Thermal Camera

EST-enabled thermal cameras are displayed with the same pane features as regular Thermal or Visible-spectrum cameras.

An EST-enabled camera can generate the following Events:

- “Screening: Alarm triggered”
- “Screening: Temperature within limits” – Camera successfully read the temperature and it was not above the threshold.
- “Screening: No face covering” – Triggered when camera detects that a person’s face is not covered.
- “Screening: Alarm - Missed reading” – Camera that the reading failed - shows in event description.

Viewing Tile Toolbar

The viewing tile toolbar displays basic information about the displayed entity - principally, its name, but may also include various buttons depending on the displayed entity's type. To enable maximum video real estate and a more comfortable way to control it, the viewing tile toolbars are semi-transparent overlays.

The opacity level of the toolbar background and buttons as well as the visibility of the tile toolbar and the tile number can be set using the **Tools -- Options Menu**. By default, the toolbar background is very opaque and it fades when the cursor is not placed on top. The buttons are visible and the Armed Tile button is always visible.
**Viewing Tile Control Icons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Entities</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="2" /> <img src="image" alt="4" /></td>
<td>All</td>
<td>Tile's logical ID. Also used to arm it for instant replays/alternative content (one click) (Orange) or alarms (two clicks) (Red). Blinks when an alarm/instant replay activates.</td>
</tr>
<tr>
<td><img src="image" alt="Microphone, Video Clip" /></td>
<td>Microphone, Video Clip</td>
<td>Adjust the volume from the source</td>
</tr>
<tr>
<td><img src="image" alt="Camera" /></td>
<td>Camera</td>
<td>Digital zoom - click to activate and then use click-and-drag in the Viewing tile to define the area to be displayed</td>
</tr>
<tr>
<td><img src="image" alt="Camera" /></td>
<td>Camera</td>
<td>Start and stop listening to the audio inputs linked to the displayed entity.</td>
</tr>
<tr>
<td><img src="image" alt="Camera" /></td>
<td>Camera</td>
<td>Start and stop transmitting audio through a linked microphone.</td>
</tr>
</tbody>
</table>

**Note:** This microphone can send audio to all cameras that are:
- Linked with an audio-out device
- Activated by pressing the transmit button
- In the live view

<p>| <img src="image" alt="Camera" /> | Camera | Start and stop manual recording of the camera scene. |
| <img src="image" alt="Camera" /> | Camera | View an instant replay of the live video. You must have at least one tile armed for alternative content to view instant replays. |</p>
<table>
<thead>
<tr>
<th>Button</th>
<th>Entities</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▶️</td>
<td>Video Clip, Sequence</td>
<td>Increase a video clip's playback speed (displayed by the tile ID) or start forward playback when in reverse mode. When viewing a sequence, use the button to jump to the next camera.</td>
</tr>
<tr>
<td>◼️</td>
<td>Video Clip, Sequence</td>
<td>Pause a video clip's playback or, when viewing a sequence, to prevent progress to the next camera until you click the button again.</td>
</tr>
<tr>
<td>◄️</td>
<td>Video Clip, Sequence</td>
<td>Increase a video clip's reverse playback speed (displayed by the tile ID) or start reverse playback when in normal mode. When viewing a sequence, use the button to go back to the previous camera.</td>
</tr>
<tr>
<td>←</td>
<td>Map</td>
<td>The &quot;Back&quot; button when viewing a map (same as in a web browser).</td>
</tr>
<tr>
<td>→</td>
<td>Map</td>
<td>The &quot;Home&quot; button when viewing a map (same as in a web browser).</td>
</tr>
<tr>
<td>↓</td>
<td>Map</td>
<td>The &quot;Forward&quot; button when viewing a map (same as in a web browser).</td>
</tr>
<tr>
<td>✔️</td>
<td>Alarm</td>
<td>Acknowledge an alarm.</td>
</tr>
<tr>
<td>❌️</td>
<td>Alarm</td>
<td>Snooze an alarm.</td>
</tr>
</tbody>
</table>

When the contents of a live video tile is being recorded, a red circle appears in its toolbar to the right of the arming/logical ID button.

**Armed Tiles**

The user can 'Arm' one or more tiles, so that those tiles will be used for specific uses.

For example, one or more tiles can be set to 'Armed for Alarms'. Then, if an alarm that has an associated camera is triggered, the video from that camera will be displayed on an available 'Armed for Alarms' tile.

Similarly, when content needs to be displayed from a non-alarm-related event, it will be directed to an 'Armed for Alternative Content' tile. If the ControlCenter user clicks 'Instant Replay' on a tile showing live content, the 30-sec delayed video of that tile will start in an 'Armed for Alternative Content' tile.

Tiles are armed by clicking on the Tile number in the lower left corner of the tile.

The three possible arming states, indicated by the color of the left part of each tile’s ID button, are: unarmed (clear), armed for alarms (red) and armed for alternative content/instant replays (orange). A tile’s arming state does not effect its capabilities (i.e. what kind of entities it can display) but does determine whether its content may be replaced, under certain circumstances, without any user action.
Click 0-                  Unarmed: Indicates that the Tile is not armed and behaves according to the configured default Layout behavior for unarmed tiles.

Click 1-                  Armed for alternative content: Indicates the Tile has been armed as the target Tile for incoming "alternative content". When this content is sent to the ControlCenter (such as the IR button being clicked) the Layout will use this tile to load it.

Click 2-                  Armed for Alarm: Indicates the Tile has been Armed for Alarm.

Click 3-                  Return to Unarmed

The following rules govern how armed tiles are activated:

For Instant Replays:

1. If any tiles armed for alternative content are empty, the instant replay will be displayed on the first (i.e. lowest numbered) of them.
2. If all tiles armed for alternative content are in use, the instant replay will be displayed on the first tile displaying something other than an instant replay.
3. If all tiles armed for alternative content are displaying instant replays, the instant replay will not be shown. You must clear one of the armed tiles or arm an additional tile to display an instant replay in this case.

For Alarms:

1. When an alarm is triggered, ControlCenter first checks if any ‘armed for alarms’ tiles are available – i.e. not currently displaying an active alarm. If so, the alarm will be displayed on the lowest numbered of them (even if it is displaying some other content).
2. If all armed tiles are displaying active alarms, the new alarm will replace the one with the lowest priority if its own priority is higher.
3. If the new alarm's priority is equal to or lower than the lowest of the displayed alarms’ priorities, it will not be displayed until an armed tile becomes available (i.e. if one of these alarms is acknowledged, forwarded or snoozed). If multiple alarms of the same priority are active but waiting to be displayed, the oldest will be shown first (i.e. the first criteria is priority, the second age).

If multiple alarms occur, the highest priority will load first, and subsequent lower priority cameras will display following in sequence. When a number of alarms occur, their cameras will be distributed each in turn with the individual alarm across the available "Armed for alarm" panes. For any particular user, display will be activated according to that user's alarm display setting (Block mode, Flat mode, or Salvo mode.).

For greater explanation of these modes see AdminCenter Help - Configuring an Alarm with Cameras and explanations of the behavior in Displaying a Camera on Alarm (manual and automatic).

You can always view an alarm by dragging and dropping it from the Alarms Pane to an unarmed tile. Once an alarm is displayed, however, you cannot replace it with any other content. It must be
An alarm may be "copied" to another tile in the form of a client-side sequence. This allows a user to switch between the scenes displayed by the alarm manually, regardless of the dwell time. Copying an alarm has no effect on its status.

**In-Tile PTZ Controls**

When using a mouse which has a scroll-wheel, you can control digital and analog PTZ functionality directly from the tile:

- To enter PTZ control mode with your mouse hovering over a tile, click the scroll-wheel button. Depending on the mouse's location in the tile, the cursor will turn into one of eight directional green arrows.
- To pan or tilt, move the mouse so that the cursor points in the direction in which you would like to move the camera in and click the left mouse. The speed of the movement is proportional to the distance from the of the cursor from the middle of the tile.
- To zoom in, scroll upwards with the scroll-wheel, to zoom out, scroll down with the scroll-wheel.
- To exit PTZ control mode, click the scroll-wheel.
5.3.1  Thumbnail Search

When a Query is executed with Thumbnail Search as the Query type, a new Thumbnail Search Layout is opened.

5.3.2  Using Draw-to-zoom with Thumbnails

When viewing Playbacks using a thumbnail search, it can be useful select a specific area and then zoom into that area in the thumbnails, in order to isolate an event.

**Note:** Draw-to-zoom' capability is not available on Panoramic cameras - see Panoramic cameras.

Hover the mouse in the Playback Pane to access the Draw-to-Zoom control.
Select the area to magnify.

The Thumbnails are all sized to display the selected area.
Hover the mouse in the Playback pane to see the extent of the zoom.
5.3.3 Digital Presets

In addition to the presets that can be used for regular PTZ cameras, the user can also treat input from a fixed camera as if it came from a PTZ. By zooming in so that only part of the view is shown, the normal controls (in-screen or via the PTZ pane) can be used, and different resulting images saved as **Digital Presets**.

5.3.3.1 Defining Digital Presets

The picture below shows an external camera, with various parts shown as potential ‘Presets’.

1. Choose the area/s that are to be designated as Presets.
1. Use the viewing controls (in-screen or via the PTZ pane) to zoom and pan until the required scene is shown.

1. Right-click to open the Context Menu, and click on Save as Preset.

1. Choose the Preset number to be associated with this scene, enter an appropriate Name, and Save.

Preset numbers and names can also be set in the PTZ pane

1. Click the drop-down arrow (to the right side of the Edit area) to select the number to be used for the preset.

2. Click Edit and enter the name to be used

3. Click Save (this only saves the name)

4. Click Set to set the current view as the Preset.
5.3.3.2 Using Digital Presets

- When viewing live or recorded content from fixed digital camera, the user view content from the Preset view of that camera by right-clicking to open the context menu, and selecting Go to Preset.
- Even when viewing recorded content, presets can be defined that allow a specific view to be shown from the recorded material.

New Preset created to give a wide view
Using the Preset view in recorded content
(here giving a long view of a detailed subject from another camera)

**Note:** The Context Menu only provides access to the first 12 Presets (similar to the way the PTZ window only has 12 buttons for selecting Presets. Where additional Presets have been defined, they can be accessed from the PTZ Pane, by clicking on the drop-down button and selecting from the list.

**Camera Sequences**

"Go to Preset" can be set as an **Action** from fixed cameras.

### 5.3.4 Quick View

Quick View allows the Control Center Operator to click on predefined screen overlays to switch view from the current camera to an alternative. This would typically be another camera that covers an 'off-screen' area - such as an adjacent room.

A Quick view can be defined for any camera/s in the system (This is done on the Admin center).
Once the camera's Quick View is defined, the Camera's normal view screen shows overlays that act as switch icons, taking the operator to the alternative screen.

**IMPORTANT NOTE:**
In order for the feature to be used, the following criteria must all be met:
- the camera has a Quick View defined
- the Operator has rights to use the Quick View feature for this camera
- and the feature is enabled for this camera
- the operator is in regular View or Playback mode

(The feature cannot be used for a screen activated by an Alarm, displayed as part of a camera Sequence, or played as part of a Synchronized Playback).

The feature is not supported in EZ Client.

This is how the alternate cameras might correspond to the 'direction' the operator might want to look if, for example, a person in view moved off-screen in the area indicated by the overlay.

---

**5.3.4.1 Quick View enabled in a Pane**

**Quick View Enabled in a pane**

The large pane (1) below has 5 overlays in view - each corresponding to an alternate camera which was defined as being relevant to that 'direction'.

5.3.4.2 Using Quick View

Quick switch
Double-click on an overlay immediately replaces the current camera with the camera represented by the overlay.

Highlight and check camera name
Mousing over an overlay highlights it, and a Tooltip shows the name of the camera that it represents.

Highlighting a Zone with the mouse
**IMPORTANT** - If the current user is not authorized to view one of the cameras defined in the Quickview, then the overlay corresponding to that camera will not be shown.

**See Preview**
A single click on the overlay shows a live Thumbnail view of the indicated camera (or a video of the relevant clip when in Playback mode), and the mouse cursor will change to a “hand” type in order to indicate to the user that Quick View zone area is clickable.

Initially, this window will present the associated camera’s name and show a loader until the video stream is ready. The Loader will also be shown if retrieving the video clip takes time.

**Preset view in the Preview window**
The overlay may represents a Preset view

*Digital presets* (i.e. on fixed cameras), will be shown in the preview immediately.

*PTZ* presets are not shown in the preview window, because the users has not selected the view (Click the preview or double-click the overlay).

The system will not initiate moving the camera until the actual selection is made.

**Problems with displaying the designated camera**
If the video cannot be displayed for some reason: communication issue, absence of the video (in case of playback) or other error, an error message will be displayed in the preview window.

**Switch from Preview window**
If user clicks anywhere inside the preview window, he will switch to the linked camera.

If there is a Quick View defined for the second camera, then Quick View will already be enabled when you reach the second camera.

**Returning to the first camera** - *(the second camera needs it’s own Quick View)*
REMEMBER: There is no automatic ‘Return Path’ once the second camera has been selected, unless a Quick View has been defined for the second camera, with a zone that corresponds to back to the first.
(The Setup in the Admin Center has a specific facility to make this setup easy.)

5.3.4.3 Quick View - further details

1. When Quick View is enabled in the tile, it will remain that way throughout the navigation process, unless a new camera is dragged into the tile or an incoming alarm replaces the scene in the tile (if it was armed). In that case, the Quick View button will reset and Quick View zones, even if available for the new scene, will initially be hidden.

2. When selected tile is presenting Quick View zones and user selects another tile, the Quick View zones in the previously-selected tile will be hidden but the Quick View enable button will remain toggled on. If user moves back to that tile and selects it again or hovers over it, the Quick View zones will automatically reappear, without needing to enable the Quick view feature in that tile again.

3. When a camera is opened in a tile by incoming alarm, since the tile is locked, the Quick View feature will be disabled, and the Quick View enable button won’t be visible.

5.3.4.4 Quick View in Playback

Preview when in Playback

Time and speed in Preview window

Time and speed of Playback in Preview window

When the preview is being shown, the playback time is shown in the preview window, and the speed of the preview playback will be the same as in the camera in the playback window.
1. When a user opens a playback of a camera which has Quick View zones, and he has access rights to at least one of the Quick View zones (to the linked cameras) the Quick View enable button will appear in the tile. Initially its state will be off.

2. When Quick View is enabled and zones are displayed, preview windows will show a related playback video of the SE zone.

3. When playback is played at increased speed, the preview window will show a video at the same speed as the playback window.

4. When user is watching a playback video in the tile, and Quick View is enabled and zones are displayed, preview windows will show the related playback video of the Quick View zone from that corresponding time.

5. If a camera is detached from the system, Quick View zones from the detached camera will still be available, since detached cameras still contain recordings.

5.3.5 Controlling Output Pins linked to Cameras

When an Output Pin is linked to a camera, then, if the operator moves the cursor to within the camera’s viewing tile, the Output Pin icon is shown, and the icon shows the ‘current’ state.

Hovering on the Output Pin Icon shows a tooltip and the state the pin will change to if clicked.
Linked Output Pin Inaccessible

If the camera on which the Output Pin is defined becomes inaccessible, the Output Pin Icon is shown greyed-out, and if the mouse is placed on it, a status tooltip is shown.

5.3.6 Adaptive Streaming

Adaptive Streaming saves bandwidth and enhances system performance by tailoring a video stream’s resolution to the size of the viewing tile. The system displays high-resolution images when the image is shown in larger tiles or full-screen mode. When shown in smaller tiles, not so much resolution is needed, so the stream can be reduced.

By default, Adaptive Streaming is enabled in each Control Center client. To disable Adaptive Streaming for a ControlCenter, go to Tools/Options/Video and deselect the Adaptive Streaming check-box.

To disable Adaptive Streaming for a given camera, right-click the tile in which it is displayed and deselect Adaptive Streaming.

Adaptive Streaming is currently available with FLIR’s Ariel, Quasar, and Quasar Gen 2 edge devices.

5.3.7 Hide/Show Privacy Mask (Deactivate)

Note: Only available when connected to a <%HOSTSYSTEM%> system

On systems that support Privacy Mask, cameras and camera sequences can have an overlay grayed-out are on an image that prevents viewing that part of the video image.
Caution: The reasons that masking was created on the video can vary and thus before a user removes masking from a video that may be displayed in view on a monitor, a certain level of discretion and background as to why the mask was put on the video in the first place should be considered. You may want to consult a Supervisor or Administrator of the system to learn more about the scene’s Privacy mask. In some jurisdictions, privacy masking laws may apply.

For live video scenes and exported video, the following behaviors can be expected:

- If the video is from a live display in the Tile layout, the credentials from login will automatically allow an authorized user with mask privileges to remove the Privacy Mask and see the privacy zone underneath it.
- If the video is from a Archiver recording being played in the Tile layout, the credentials from login will automatically allow an authorized user with mask privileges to remove the Privacy Mask and see the privacy zone underneath it.
- If the video is from an exported recording in DVT format (only) and being played in the Tile layout, in order to remove the mask during playback, you must enter the system assigned Privacy Mask password that was in use when the video file was exported. This is a separate password unrelated to System login and can vary based on the active system-wide Privacy Mask password at the time the file was export and which System entity system it was exported from.
- If the video is from an exported recording in AVI format, the masking is permanent as part of the image and cannot be removed.

It should be noted that some cameras have privacy masking capabilities that may have been configured outside of the system that may embed the masking in the video.
To hide/show a privacy mask on a ControlCenter tile

1. If the Privacy Mask is displayed on, on the video image displayed in a Layout Tile, do the following:
   a. Right-click and select **Deactivate privacy mask**.
      If the video is live or an Archiver recording playback, the hidden area becomes visible.
      If the video is from an exported video clip, you will be prompted for a password.
   b. If prompted for a password, enter the Privacy Mask system-wide password that was active when the specific video clip was exported and then click OK.

   ![Privacy Mask is turned on and the Privacy Zone is hidden - right click menu to disable](image1)

   ![Privacy Mask is turned off and the Privacy Zone is visible - right click menu to enable](image2)

**Note:** This password will be stored and will not need to be entered again. Only after unloading the clip from all panes or from closing the ControlCenter does the password get clear.
**Caution:** If you leave the an exported clip which you entered a password for loaded in the ControlCenter and you log out from the System, the ControlCenter will only switch to offline and the passwords you entered will remain for each video still loaded in the offline ControlCenter panes. It is recommended when you are finished viewing a clip that you have entered a Privacy Mask password for, that you remove it from the tiles, Timeline and File Playback pane.

2. If the Privacy Mask is turned off, on the video image displayed in a Layout Tile, right-click and select Activate privacy mask.

### 5.3.8 Spot Monitor

Spot Monitor enables the user to select the tile in which a scene will appear by default when double-clicked.

To enable Spot Monitor: Right-click the desired tile in the Tiles pane, and then select **Spot Monitor**. Once a tile is selected as spot monitor, its edge remains highlighted even when another tile is selected.

### 5.3.9 Viewing GIS Maps

**Note: Only available when connected to a `<HOSTSYSTEM>` system**

The GIS Map entity allows the ControlCenter Operator to display the initial map according to its stored GIS parameters (Longitude, and 'Eye Altitude').

Select the GIS Map you want to display, and drag it to the required tile. (In this case, the example is the Default GIS Map).
It is possible that, because of the location of the map and the selected 'Eye Level', that none of the selected GIS entities are shown.

You can use the standard map zoom and navigation tools to change the map until you see the GIS entities displayed.

Alternatively, you can select one of the entities that are defined with GIS coordinates, display it in one of the Viewing Tiles, and then right-click and select 'Show my location' from the context menu. This will cause the GIS map to zoom and center the selected GIS entity. The entity’s icon will appear in the GIS map.

GIS Entities in a GIS Map.

The following entities may be shown in a GIS Map.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Entity</th>
</tr>
</thead>
<tbody>
<tr>
<td>📷</td>
<td>Fixed Camera</td>
</tr>
<tr>
<td>📷🚨</td>
<td>Fixed Camera, Alarm</td>
</tr>
<tr>
<td>🎥</td>
<td>PTZ Camera</td>
</tr>
<tr>
<td>🎥🚨</td>
<td>PTZ Camera, Alarm</td>
</tr>
<tr>
<td>🎥켈</td>
<td>Mobile Camera, Live</td>
</tr>
<tr>
<td>🎥㎞</td>
<td>Mobile Camera, Playback</td>
</tr>
<tr>
<td>🎥🚨</td>
<td>Mobile Camera, Alarm</td>
</tr>
</tbody>
</table>

**Show video when Hovering**

If the GIS Map was defined with the parameter 'Show video when hovering' enabled, then a small window showing the video from the selected camera can be shown by hovering the mouse on the relevant icon. A tooltip also shows the entity’s name.

![Show video when Hovering Image]

**5.3.10 Panoramic Cameras**

Panoramic cameras such as the Quasar Gen 2, or cameras equipped with Immervision Panomorph® lenses allow the user to ‘plunge’ into the picture. The illustration below shows the typical ‘fish-eye’ image from a panoramic camera, and how the PTZ compass control (or the mouse PTZ control) can be used to navigate ‘into’ the picture.

**Note:** Panoramic cameras do not provide ‘draw to zoom’ capability. The mouse controls are used to ‘plunge’ into the picture, and to navigate within it.
Multiple pictures can be generated from the fish-eye image, and shown in a Tile Layout.

To Create Tile Layout with multiple views
In the ControlCenter, choose a tile layout for setting up the camera, and save it using the Save Layout icon on the toolbar.

Drag the camera image into each of the tiles.
Using the **PTZ compass controls**, or the mouse PTZ control capability (described in the Viewing Tile section), set up different views in each of the tiles.

4. If any of the individual views might be used in other layouts, you can save them as individual **Digital Presets**.

### 5.3.11 Viewing Live and Recorded Video from connected DVRs

Digital Video Recorders (DVRs) that have been integrated into the Latitude system may be connected to the system. Cameras attached to the DVRs may be viewed 'live', and recordings can be accessed and played back. However, video recorded on DVRs remains stored 'on the edge', and is not transferred to the main system.

Functions handling content from the DVRs are slightly different from content residing on the main system. These are described below.
Cameras attached to the DVR are shown in the Logical View as regular cameras.

**Supported DVR features:**

1. Live Video - Displayed by dragging an attached camera to a viewing tile
2. Query - normal query - e.g. select the camera, right-click and choose ‘Send to Query’ from the drop-down. Available clips from that camera are shown in the Query results pane.  
   **Note** - Queries are cached, so the second time a query is accessed, response is much quicker - useful when looking though a clip using the Timeline.
3. Playback
   a. Jump To Time (via timeline)
   b. Slow Forward.
   c. Fast Forward.
   d. Pause.
   e. Continuous Playback - When playback of the current clip completes, the next cached queried clip will start playing.

**Limitations on Content stored on DVRs**

1. No Export from Timeline.
2. No Motion indication on the Timeline.
3. Playback
   a. No Step Forward/Backward, Reverse Playback.
   b. No Operations on selected portions of the Timeline (such as Lock, Start Loop Playback, etc)
   c. No Synchronized Playback.

**5.4 Viewing Modes for Alarms**

**Automatic and Manual Display**

When alarms have been configured to display content from cameras when triggered, the display can be Automatic or Manual.
**Automatic Display**

A queue is maintained for all alarms that have been configured to display content (live and/or recordings). When an alarm is triggered and one or more cameras (or recordings from cameras) associated with it must be displayed, then it is added to the queue. Items in the queue will be displayed in Armed tiles, according to the display mode set for that user (User/General/Alarms Display Mode).

See below: [Alarm Display Modes](#).

In order for the Automatic mode to be used, the user must set one or more viewing tiles to ‘Armed for Alarms’ status.

**Note:** In all cases, Alarm Priority takes precedence over Trigger time – in other words, higher-priority alarms are placed higher in the queue than lower priority ones. Alarms of equal priority are queued according to their trigger time.

**Manual Display**

If the user does not set any tiles to ‘Armed for Alarm’ status, this means that Manual display will be used.

Content from cameras associated with alarms will be displayed by the user:-

- double-clicking on an alarm in the Alarms pane. Cameras associated with the alarm will then be displayed in the next available viewing tile
- or-
  - dragging-and-dropping the alarm directly to a viewing tile.

The display sequence in the viewing tile will follow the rules for [Block Mode](#). A subsequent alarm can be opened in another ‘next available’ tile, or dragged to a user-chosen tile, where it will also be displayed in [Block Mode](#).

**Alarm Display Modes**

**Flat Mode**

Flat mode is a simple method of showing alarms one after another (as they occur in priority sequence). Each alarm is sent to the next available ‘armed for alarms’ tile/s. If an alarm has more than one associated video, all available ‘armed for alarms’ tiles will be used. If an alarm has too many associated videos for the available tiles, the available tiles will be used and the remaining videos for that alarm will not be displayed. When alarms are cleared, meaning that tiles become available, then the next alarm in the queue will be displayed. There is no cycling of scenes. All the displayed scenes of an alarm remain in their tiles until that alarm is cleared.

**Alternative Modes**

**Note:** Only available when connected to a `<%HOSTSYSTEM%>` system
In addition to Flat mode, the system supports two alternative modes - Block and Salvo, for handling the situation where two or more alarms are automatically loading into a Layout that has one or more Tiles enabled with ‘Armed for Alarms’.

Block Mode: All scenes associated with an alarm type will be shown, in sequence, in one tile. You can see information about multiple alarms at the same time, if you have more than one tile ‘armed for alarms’.

Salvo Mode: Only one alarm is displayed at any one time. As many scenes as possible of that alarm are displayed on the available ‘armed for alarms’ tiles and they remain there for the ‘dwell time’ of that alarm. Provided all scenes for the alarm have been displayed, the next alarm in the queue according to priority will be displayed. If you do not have enough ‘armed for alarms’ tiles for the scenes of one alarm to be shown, then when the alarm dwell time passes, the remaining scenes of that alarm will be displayed before the next alarms starts being displayed.

Detail

The following table describes the graphic representations in the explanations that follow:

<table>
<thead>
<tr>
<th>Graphic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="oneAlarm.png" alt="Image" /></td>
<td>One Alarm color coded (priority) and showing associated cameras. The number at the side shows the order the alarm occurred in time.</td>
</tr>
<tr>
<td><img src="oneCamera.png" alt="Image" /></td>
<td>One Associated Camera configured to the Alarm as Live View</td>
</tr>
<tr>
<td><img src="cycle.png" alt="Image" /></td>
<td>A graphical representation of a cycle. Two types of cycles, one nested in the other, that are possible a cycle of alarms and a cycle of cameras for a single alarm.</td>
</tr>
<tr>
<td><img src="layout.png" alt="Image" /></td>
<td>A representation of the same four tile ControlCenter layout at a point in time during a camera cycle. Includes color coding of the frames to match the Alarm examples, Cameras being displayed from that alarm and green tiles for free tiles not being used by the current Alarm period. Also includes the icons on the lower left of the tile indicating if the tile is Armed for Alarm, by the ControlCenter user. If a large number is shown at the side of each layout, it indicates the order in the Alarm cycle which is priority first sequence.</td>
</tr>
<tr>
<td><img src="alarms.png" alt="Image" /></td>
<td>Armed for Alarm tile icons (red) and Unarmed tile icons (black).</td>
</tr>
</tbody>
</table>

Block Mode
Each alarm sequences all its associated video onto a single Armed for Alarm (note the red number in the lower left corner indicating this) tile. The highest priority gets the tile if there is competition.

Salvo Mode

Each alarm attempts to display its associated video on as many tiles as possible, trying to show as many cameras as possible at once. The sequence of the each alarm cycle is based on priority. Thus the highest priority alarm will go first in displaying all its associated cameras before passing it to the lower priority alarm, and so on. (Red high priority, Yellow intermediate, and Blue low priority.) The following represents a individual tiles in a time sequence (four per layout) and layout (three, one for when each alarm displays) a timed cycle. The small blue nodes represent different cameras associated with each alarm (count 3,3, and 2)
There is no pause button for Salvo mode. In order to see a video you will need to drag out the sequence into a free tile. For more information see the following section Dragging and Dropping One Alarm Sequence Out of a Salvo Group.

**Note:** If your user settings have been set for you to work in Salvo Mode, it is important that you keep sufficient tiles ‘armed for alarms’ so that you can see all the scenes associated with an alarm.

**Dragging and Dropping One Alarm Sequence Out of a Salvo Group**

The result is that the Salvo will continue with the remaining Alarm video cycles and the removed Alarm cycle will sequence on its own in block mode.
The benefit is that the Alarm that is pulled out can now be paused using the OSD pause button overlay that stops a block mode sequence from rotating while you view the video.

A pause video sequence on a drag-n-drop from a Salvo to a Block mode

A block mode sequence displays an alarm and multi-video indicator

Note: In order to Remove a Salvo, the Alarms that are displayed with videos, must all be cleared or snoozed.

5.5 Synchronized Playback

Synchronized playback is used to play multiple synchronized video clips. It is launched from the Query Pane by clicking Sync after conducting a query.

Synchronized playback may also be initiated from the Play button, if multiple clips are selected. See Query Results Pane.

Viewing Synchronized Clips

In the Query Pane, check the cameras you wish to view in a Synchronized Playback Layout.

⚠️ This feature is very resource-consuming. ControlCenter may exhibit unpredictable behavior if too many clips are played back simultaneously.

1. To reset Query parameters and return to a default search, click.
2. From the Search for menu, select Clip.
3. Select scenes for recorded source scenes, by marking the tree entities. You can select from one up to the maximum number of scenes as defined in the Tools ► Options ► Video ► Playback screen settings. The default is six maximum.
4. From the Date and Time menu, select a preset time option -or-
   Select Manual selection and then enter From date and time and To date and time.
5. Click Sync.
   The clips found by the search load into the Timeline - Synchronized Playback Layout.
6. Once the sync playback layout is opened, the User is able to drag to open scenes from the main camera tree.
   a. When a scene is dragged into an empty tile, it will be automatically synced with the other scenes in the layout. The unified Timeline will be updated to include the new scene.

   Drag and Drop camera from tree into Sync Playback layout
Camera drops into layout, expanding the number of tiles if needed.

b. If the scene is dropped into a populated tile, it will open the new scene in the next available tile. If no tile is available, the layout will be automatically modified to include more tiles.

c. Scenes with linked audio will take two tiles, which will also expand the layout if necessary.

7. Scenes can also be dragged out of the layout to remove them and the unified timeline will be removed for that scene.

One scene (the "original" scene in the top left tile) must always remain in the Sync Playback layout in order to keep the playback times.

You can fast-forward, rewind or jump to a new time in the displayed clips by using the timeline.

**Privacy Mask Passwords when using Synchronized Playback**

*Note: Only available when connected to a `<%HOSTSYSTEM%>` system*

Because the Synchronized playback may include multiple files that can be from other systems, different scenes and span various times, the possibility that the files were exported with different Privacy Mask passwords.

Playback will automatically play with masking enabled and areas of the video occluded.

The functionality of Synchronized Playback with regards to removing Privacy Mask with passwords is as follows:

- You will need to enter the Privacy Mask password for each scene you want to disable the Privacy Mask on before you can disable the Privacy Mask.
Synchronized Playback

- You do not need to enter the Privacy Mask password more than once when the clips are loaded in the Synchronized layout.
- You can enter newest scene clip's password and you will need to enter the older clip passwords that are loaded with it in the Synchronized layout.
- The password remain viable as long as the clip is loaded in the Synchronized layout, Timeline and File Playback panes whether or not you are working online or offline (i.e. If you logout from the system and leave the clips loaded, the passwords and access remain available for you on the offline workspace.) Enabling and disabling the Privacy Mask works the same in the Synchronized layout as it does in the default layouts.
6  Workspace Panes

The **Workspace** pane is located on the lower right section of the workspace. The user can select what to show in the Workspace by selecting the appropriate tab.

![Pane Toolbar](image)

<table>
<thead>
<tr>
<th>Pane name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Results Pane</td>
<td>Shows the returned results of queries and provides features for displaying the results in the other panes and Layout.</td>
</tr>
<tr>
<td>Clips Pane</td>
<td>Provides tools for browsing, opening and selecting recordings and playing them</td>
</tr>
<tr>
<td>Timeline Pane</td>
<td>Provides the ability to view clips, bookmarks and associated content in an organized linear time/date oriented workspace.</td>
</tr>
<tr>
<td>Export Status Pane</td>
<td>Provides an interface for organizing and monitoring the exporting of recordings and clips with optional advanced file export features.</td>
</tr>
<tr>
<td>Events Pane</td>
<td>Provides a workspace for viewing, filtering, and researching events and event relational info.</td>
</tr>
<tr>
<td>Alarm Pane</td>
<td>Provides features and information for researching, assigning, following procedures, clearing, entering resolutions and generating alarms.</td>
</tr>
</tbody>
</table>

**Note:** If you do not see a particular icon, this will be because the associated pane has removed. The icons and their associated panes can be restored by checking them in the Main Menu/View/Content drop-down.
6.1 Query Results Pane

The Query Results Pane lists the results of queries performed in the Query Pane, and Motion Query Pane.

<table>
<thead>
<tr>
<th>Scene</th>
<th>Start Time</th>
<th>End Time</th>
<th>Expiration Time</th>
<th>Archiving Trigger</th>
<th>System Name</th>
<th>Digital Signature</th>
</tr>
</thead>
</table>

**Lock** Multiple clips
When selecting clips to be locked/unlocked, multiple clips may be selected.

(Shift-click or Ctrl-click on clips for range or individual selection)

**Play** multiple clips
If multiple clips are selected in a Clip or Bookmark Query, the Play button will open a synchronized playback layout and play the clips there.

The Query Results pane also lists results from CaseBuilder Queries.

**Note: Only available when connected to a Latitude system**
Aside from the retrieved clips' start and end times, the results pane displays each clip's Expiration Time (the time it is scheduled to be erased from storage), Archiving Trigger (scheduled, manual, event or alarm-based recording, or ‘Edge’ for recordings recovered from Storage-on-the-Edge devices)
and whether or not it has been locked (to prevent the clip from being erased even after its expiration time).

The query results are sorted by time in ascending order. The query may return partial results because the amount of results exceeds the limit that is specified by the query. Sorting the query enables the user/SDK to change the time filter and page to the next results.

There are five buttons at the top of the pane:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>Click this button to clear the selected query result from the list. To clear the entire list, click and choose <strong>Clear All</strong>.</td>
</tr>
<tr>
<td>Export</td>
<td>Click this button to export the selected clips.</td>
</tr>
<tr>
<td>Lock</td>
<td>Click this button to lock or unlock the selected clips. Multiple clips may be locked/unlocked.</td>
</tr>
<tr>
<td>Validate</td>
<td>Allows user to validate the clip by checking the digital signature. <strong>Note:</strong> Clips have a digital signature appended if, at creation time, the Archiver to which they were attached had the option 'Tamper proof archiving' enabled. This setting is made in the AdminCenter Archiver/Storage Tab.</td>
</tr>
<tr>
<td>Edit</td>
<td>Not used.</td>
</tr>
<tr>
<td>Group</td>
<td>Click this button to change how results are grouped. The available options are: no grouping, by scene, and by incident.</td>
</tr>
<tr>
<td>Add to case</td>
<td>Click this button to add the selected clips to the open case in the CaseBuilder Navigation Tree.</td>
</tr>
</tbody>
</table>

When a clip is exported, an "Export" event appears in the Event Status Pane, displaying the export progress. When the system finishes exporting the clip, the progress will be displayed as 100%. This provides a confirmation that the exported clip is now safe to view.

### 6.2 Clips Pane

The **Clips** pane is used to play exported clips in .DVT Format. It enables the concurrent playing of multiple media clips that occurred at the same time and were recorded by different cameras or audio sources. In addition, media clips that were exported in segments can be played as one clip. In the File Playback pane, you can also validate the authenticity of any .DVT Format clip, and indicate whether or not a clip has been tampered with.

The top of the pane contains the following buttons:
### Clips Pane

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Clip" /></td>
<td>Click this button to add files or folders to be played in the File Playback pane.</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Click this button to clear an alarm or alarm related action from the table. An alarm may be cleared only after it has been acknowledged or forwarded.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>Click this button to remove all clips, with a check mark, from the table.</td>
</tr>
<tr>
<td><img src="image" alt="Validate checked clips" /></td>
<td>Click this button to validate the selected files.</td>
</tr>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Click this button to group the files.</td>
</tr>
<tr>
<td><img src="image" alt="Selection" /></td>
<td>Click this check box to select or deselect files.</td>
</tr>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Click this button to play files.</td>
</tr>
</tbody>
</table>

You can perform the following actions:
- Adding clips
- Removing clips
- Validating the digital signature of clips
- Playing clips

The File Playback window can also be used to play back **Scene Tracker** files.

**Note: Only available when connected to a Latitude system**

Adding Clips to the File Playback Pane

You can select individual clips or whole folders to be added to the File Playback pane.

**Note:** You can only add folders that contain clips. The content of sub folders are not automatically added.

**To add clips:**
1. Click the ![Clip](image) button to add a file.
   - The Open dialog box appears.
2. Select the desired clip, and then click Open.
   - You can select one clip at a time.
   - The selected clip is added to the File Playback pane.

**To add folders:**
1. Select the ![Folder](image) button, to add a folder.
   - The Browse for Folders dialog box appears.
2. Select the desired folder.
   - You can select one folder at a time. Make sure the folder contains clips. Clips that are located in sub folders will not be added automatically.
3. Click OK.
   - The selected folder and the clips contained in it are added to the File Playback pane.
Removing Clips from the File Playback Pane

You can remove clips from the File Playback.

To remove clips or folders:
1. Select the desired clips or folders.
2. Click the Remove button.
   A confirmation message appears, asking you whether or not to delete the selected items.
3. Click OK to remove the clip(s).

Validating the Digital Signature

Every clip exported in the .DVT Format contains an encrypted watermark to ensure that the data cannot be tampered with. You can validate the files in the .DVT Format and indicate whether or not the files have been tampered with in the File Playback pane.

It is possible to playback files even if they are indicated as invalid. The validation status of the clips appears in the Digital Signature column. A clip can be validated, unchecked or not valid.

To validate the digital signature of a clip:
1. Select the desired clip(s).
2. Click the Validate checked clips button.
   While the system is validating the clips, the Digital Signature column will display the Validating status.
   After the validation process is complete, the Digital Signature of the clip will display as valid or not valid.

Playing the Clips

Once a clip has been added to the File Playback pane, it can be played and will be displayed in the Viewing pane.

- It is possible to play clips continuously, using Loop Playback.
- It is possible to play multiple clips simultaneously by selecting several clips at once.
- In addition, it is possible to play clips synchronously. For more information, see Synchronized Playback.

Once a clip is played, the Timeline pane is displayed.

To play a clip:
- Double-click the desired clip(s) in the File Playback pane.
- Drag and drop the desired clip to a tile in the Viewing pane.
- Select the desired clip(s) in the File Playback pane, and then click the Play button.
- It is recommended when you are finished viewing a clip that you remove it from the tiles, Timeline and File Playback pane.

Note: If you log out of the associated System system, files loaded in this pane will remain available for offline playback.
Removing Privacy Mask During Synchronized Playback

**Note: Only available when connected to a Latitude system**

If you have loaded a clip that was exported with a Privacy Mask, it will be password protected. Once you enter a Privacy Mask password for a scene, the system will remember it during your current session and you will not need to enter it again.

If a clip has been added and is playing you can right-click and select Deactivate Privacy Mask. You will be prompted for the password for the file you clicked on. Enter the password of the file and click OK.

If you have multiple exported clips with different passwords but for the same scene, you need only enter the latest password to unlock all of the scene.

Caution: If you leave an exported clip which you have entered a password for loaded in the ControlCenter and you log out from the System, the ControlCenter will only switch to offline and the passwords you entered will remain for each video still loaded in the offline ControlCenter panes. It is recommended when you are finished viewing a clip that you have entered a Privacy Mask password for, that you remove it from the tiles, Timeline and File Playback pane.

### 6.3 Timeline

When a focused Viewing Tile is showing the playback of a clip, the Timeline Pane presents detailed information for the archived clip (or clips, in the case of Synchronized Playback), in the form of colored bars representing the recordings, and flags or colored highlights to depict information contained in the recordings - such as Alarms, Bookmarks and Motion events.

The Timeline provides tools for navigating the content - zooming to provide finer granularity, and moving earlier or later to see other clips that may be available from the selected source/s.

The display includes a Time Ruler (hours above, minutes below) showing the time scale that applies to the recording tracks. The user can move this left or right by clicking on the the Scroll bars to move earlier or later.

Below the Time Ruler, the pane displays one or more Recording tracks. The first line shows times during which any of the selected sources have recordings. Then below that, the pane shows any other recorded information for the selected source/s.

**Recording Triggers**

A recording may be associated with multiple recording triggers. For example, a user may start manually recording a camera that is already being archived by a schedule. In such cases, the quality and time-to-live settings applied to the clip are, respectively, the highest and longest for the relevant triggers.
6.3.1 Selecting a clip

Note: Clicking and dragging when the mouse is positioned on a track does not change the time scale but rather is used to mark parts of the clip for Export or Locking.

Selecting a Segment to lock or export a part of a clip:
The timeline can be used to Export or Lock a part of an archived clip. Click and drag the mouse over pertinent section of a track.

When the desired time frame is selected, release the mouse to mark for export or lock

Hovering over the marked indication, shows the start and end time as selected.

The user can then click the Lock or Export buttons, respectively, in the toolbar section on the top left, or right-click the timeline to open the Context Menu.
The user can then select the appropriate action.

You can also mark the beginning and end of the desired section by using the and buttons.

When a clip is exported, the status, time and progress of the ongoing export appears in the Export Status Pane. When the system finishes exporting the clip, the status and time provides a confirmation that the exported clip is now safe to view.

6.3.2 Scrubbing

1. There are two methods of scrubbing:

   **Scrub the video directly in the Playback pane**

   Drag the timeline cursor earlier or later, and watch the playback in its current window.
Scrub with thumbnails on the Timeline

Hover over the timeline and check in the thumbnails.

Thumbnails show their own Time details

6.3.3 Timeline scale and Viewing point

Using the Mouse to control the Timeline

The following facilities are available:

1. **Zoom the timescale:**
With the mouse positioned anywhere in the Timeline pane, the corresponding vertical position on the timescale is held constant, and moving the mouse wheel will zoom the timescale wider or narrower (showing more or less time)

2. **Move to another point in the timescale:**

With the mouse anywhere in the Timeline pane (but NOT on a specific clip/track*), then clicking and dragging the mouse will slide the whole timeline earlier or later.

3. **Select the displayed playback range:**

With the mouse positioned below a track, the user can select a part of the clip by right-clicking at a starting time and dragging the mouse to a later time. On releasing the mouse, the timescale will expand so that selected portion of the clip fills the timeline.
6.4 Export Status Pane

An Export is initiated by clicking on the Export icon in the Query Results Pane.

The Export Status pane is used to display the status, time and progress of ongoing and completed exports and to stop one or all ongoing export processes.

When the progress bar is green, the export is either in progress or it was completed successfully. When the progress bar is red, the export was either stopped or aborted (manually or by the system).

You can clear one or all export events from the Export Status pane by selecting the desired export events and clicking the \[ \textbf{Clear} \] button. Note that this action does not affect the export process itself.

For more information about exporting, see Exporting a Clip.

6.4.1 Exporting a Clip

You can \textit{export} a specific clip and then \textit{burn} it onto a DVD. The results are viewed in the Export Status Pane. (For more information on the \textit{Burn} process, see Applications Menu/Options Menu/Export/\textit{burn}).

To export a clip via the Query Results pane:

You can export clips directly via the Query Results pane of the ControlCenter.
1. At the bottom pane of the ControlCenter, click the Query icon.
2. From the search query pane, select clip.
3. The related camera appears in the query results pane. Place your cursor on the camera and click the Export icon.
4. The **Export Settings** dialog box appears.

![Export Settings Dialog Box](image)

5. Click browse to define a location for the exported clip.
6. Click **OK** and the Export process will start. The Export Status pane will show progress.

![Export Status Pane](image)

After the clip is exported it will start the Burn process. The results appear in the Export status pane.

**To burn a selected clip:**
1. In the ControlCenter, select Tools/Options, click Export and then Burn.
2. In the Temp Burn Location field, click browse to set the burn location folder.

   - or -

   Mark the check box to **use a default location**.

3. If required, mark the check box to **delete files after burn operation**

![Burn Options](image)

In addition, while reviewing a recorded or exported clip, you can create and export partial clips of significant events from the original clip.

It is possible to export audio and video clips in the .DVT format as well as AVI format from the ControlCenter and view them via the File Playback pane or with an executable player that can be burnt on the CD along with the exported files.
Note: If your system has the Privacy Mask feature and there is a privacy mask on an exported AVI format clip, the mask in the AVI file will not be an overlay, but embedded in the image and cannot be disabled. If you export in DVT format, anyone attempting to disable the Privacy Mask must have the authentication password issued at the time the file was generated. The password is maintained by the Administrator of the System entity to which the masked scene belonged. During Synchronized Playback if two masked files with different passwords are included, the newest password credentials will unlock the sequence to be viewed with disabled Privacy Mask (DVT format only).

For more information regarding the clip export settings, see Tools/Options Export Clip.
- To export a clip via the Query Results pane
- To export a clip or partial clip via the Timeline pane

4. Set the desired parameters:
   - Clip Segment - The duration of the exported clip. This parameter is only applicable when exporting from the Query Results pane, since export from the Timeline requires specifying start and end points.
   - Interleaved Export - Select this check box to export interleaved audio and video clips.
   - Create autorun file - Select this check box to create an autorun file for all exported files to automatically run the files after they are burnt on a disk.
   - Include player - Select this check box to automatically export and burn an executable player along with exported files that are burnt on a disk.
   - Video Codec / Audio Codec - Determine the codec of the clip.

5. Click OK.
   The clip is exported to the defined location.

To export a clip or partial clip via the Timeline pane:
1. While playing a .DVT file, mark the desired section in the timeline pane of the ControlCenter.
2. On the timeline toolbar, click the button or right-click the desired section and select Export.
   The Export Settings slider appears in the Timeline pane.
3. Set the file name, export location and whether to create a new folder for the file to be exported. If you do not fill in the fields, the system will use the parameters defined in the Export Clip Options menu.
4. To set additional export parameters, click Advanced. (This option is only enabled if set appropriately in the Tools menu)
   The advanced Export Settings dialog box appears, allowing the user to set non-default characteristics to this specific export.
5. Set the desired parameters:
   - **Clip Segment** - The duration of the exported clip. Date fields allow the user to select clips that extend over day boundaries. This parameter is only applicable when exporting from the query results pane, since export from the timeline requires specifying start and end points.
   - **Settings**
     (for more detail, see the Note on Export Settings below)
   - **Format** - Determine clip format of the audio and video clips.
   - **Interleaved Export** - Select this check box to export interleaved audio and video clips.
   - **Video Codec / Audio Codec** - (for .avi format only) - Choose specific codecs to be used from the available lists.

**Note on Export Settings:**
- Default output format is .DVT
- If the default .DVT format is deselected and no format selection is made, the Video/Audio codec selection fields are enabled and the User can manually select the Video and Audio codecs to be used.
- MP4 not available for non-H264/H265 or Privacy-Mask streams
- By default, MP4 files will be exported with associated .smi files which will contain OSD information unless "Embed OSD in Exported clip" is selected
  - **Note:** When using the default option of NOT embedding the OSD, if the clip is around 15 minutes or longer the subtitles update once every second to reduce delay.
  - **Note:** When selecting to embed OSD into MP4 clips, it is recommended that the user only use this option for short clips
• Privacy Masks are not supported in MP4 exports, and therefore clips with Privacy Masks may not be exported in .MP4 format.

6. Click **OK**.
   The clip is exported to the defined location.

**To see OSD information in .mp4 Exports**

Exports in .mp4 format will always be accompanied by a .smi-format file containing OSD information.

*.smi* is the default subtitle format used by Windows Media Player and several other Video Player applications.

If the subtitles do not appear automatically upon opening the video file in WMP,
Check the “Show local captions when present” option in the “Security” tab (press “Alt” and then Tools->Options).

If the OSD still does not show,
Click **Alt/Tools, Play** and set **Lyrics, captions and subtitles** to **On**.
Privacy Mask Note:

Note: Only available when connected to a Latitude system

When a clip which has the uses a Privacy Mask overlay is exported, the Privacy Mask feature does not use the logged-in user's privileges, but is password-protected by the system-wide Privacy Mask password. Users will not be able to remove the Privacy Mask for that exported clip during playback, unless they enter the system-wide Privacy Mask password.

6.4.2 Loop Playback

While reviewing an exported clip in the ControlCenter, you can play the clip continuously.

To play a clip continuously
1. While playing a .DVT file, mark the desired section in the time line of the ControlCenter.
2. On the time line toolbar, right-click the desired section and select Start Loop Playback.
3. To stop the continuous playing of the clip, right-click the desired section and select Stop Loop Playback.

6.5 Events Pane

The Events Pane presents a list of events that have occurred since the current user logged on to the system. Only events of the types to which the user is subscribed are displayed.
For each event, the pane provides a description as well as information on the firing entity, date and time; initiator; and the event type.

The top of the pane contains four buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ Clear</td>
<td>Clear the selected event from the list. To clear the entire list, click ▼ and choose Clear All.</td>
</tr>
<tr>
<td>✍️ Edit</td>
<td>Edit an incident’s description (not applicable to other type of events).</td>
</tr>
<tr>
<td>🗳️ Group</td>
<td>Change the grouping method.</td>
</tr>
<tr>
<td>⚤ Filter</td>
<td>Filter events by type.</td>
</tr>
</tbody>
</table>

### 6.6 Alarms Pane

The Alarm Pane is used both to trigger alarms and to handle them. The table contains basic information about the alarms the user received during the current login session. Above the table are a number of buttons providing the actions the user can carry out.

The top of the pane contains seven buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔ Accept</td>
<td>Click this button to accept an alarm. When one recipient accepts an alarm it is locked for use by any other recipients. It is possible to unaccept an alarm after it has been accepted to release it to other users.</td>
</tr>
<tr>
<td>✗ Unaccept</td>
<td>Click this button to unaccept an alarm. When a user accepted and alarm and wants to reverse the acceptance and allow others to accept and clear the alarm.</td>
</tr>
<tr>
<td>✉️ Forward</td>
<td>Click this button to forward the alarm to another user.</td>
</tr>
<tr>
<td>⏸️ Snooze</td>
<td>Click this button to snooze the selected alarm (the snooze duration can be specified by going to Options in the Tools menu. The default value is 60 seconds).</td>
</tr>
</tbody>
</table>
### Alarms Pane

Click this button to **view the procedure associated with the alarm** (if applicable).

Click this button to **clear** an alarm or alarm related action from the table. Once an alarm is cleared, it is released and can be used by any other recipient who received the same alarm.

Click this button to **manually trigger** an alarm.

Click this button to **filter** the alarm information shown in the pane based on alarm state.

<table>
<thead>
<tr>
<th>Filter Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
</tr>
<tr>
<td>Cleared</td>
</tr>
<tr>
<td>Accepted by logged-in user</td>
</tr>
<tr>
<td>Accepted by other user</td>
</tr>
<tr>
<td>Forwarded</td>
</tr>
<tr>
<td>Snoozed</td>
</tr>
</tbody>
</table>

When triggering an alarm or forwarding an existing one, a new section is added to the right-hand side of the pane, as shown below.

### Priority

Each Alarm has a priority associated with it when it is defined.

1. Critical
2. High
3. Medium
4. Low
5. Very Low

The priority is displayed in the Alarm Pane

### Displaying Alarms in Tiles

In the ControlCenter’s customizable screen configuration there is an option to dedicate one of the workstation monitors solely for alarm management, providing more real estate for the alarm task.

- Alarm video can be displayed in one of the following ways:
- When one or more tiles are ’armed for alarms’, the application automatically switches the highest priority alarms to be displayed in those tiles.
- When an active alarm icon is double clicked in the map or drag & dropped from it onto on an available tile, the alarm is displayed
- Double click or drag & drop an alarm from the alarm pane and onto a tile.
Alarm Life Cycle

ControlCenter supports a tri-state alarm life cycle: activated, accepted and cleared.
1. Once an alarm is triggered, it is sent by the system to multiple recipients and its status changes to activated.
2. One of the recipients can accept the alarm by clicking the accept button on the GUI, this then changes the alarm status to accepted.
3. When the alarm handling is complete, one of the users can clear it and in this way ends the life-cycle of that alarm instance, causing it to disappear from all recipient workstations.

Clear Alarm Description

When the option in AC is selected to force clear alarm description, the CC Operator is forced to enter a description for why the alarm was cleared.

This can be accomplished with:
- Free text description based on the situation
- Predefined description entered into AC field when alarm is created.

Color Coding

**Note: Only available when connected to a <%HOSTSYSTEM%> system**

Each alarm is defined with priority and the priorities are mapped to color codes:

Red: high priority range; Yellow: medium priority range; Blue: low priority range

In the ControlCenter application the user can view the list of active alarms in the Alarm Pane together with color coding to help the user instantly understand the priority of the alarms:
- Each alarm instance in the list is presented with its color code
- The user can sort the alarm list by priority
When an alarm is triggered, an alarm notification pops up in the bottom-right corner of your desktop. The alarm entry is added into the Alarm Pane with the proper color coding.

### 6.6.1 Displaying a Camera on Alarm (Automatic and Manual)

When alarms have been configured to display content from cameras when triggered, the display can be **Automatic** or **Manual**.

**Automatic Display**

In order for the Automatic mode to be used, the user must set one or more viewing tiles to ‘**Armed for Alarms**’ status. Cameras associated with alarms will then automatically be displayed in Armed tiles, according to the display mode set for that user. *See: View Modes for alarms*

**Manual Display**

If the user does not set any tiles to ‘**Armed for Alarm**’ status, this means that Manual display will be used.

Content from cameras associated with alarms will be displayed by the user:

- double-clicking on an alarm in the Alarms pane. Cameras associated with the alarm will then be displayed in the **next available viewing tile** -
  -or-
  - dragging-and-dropping the alarm directly to a viewing tile.

The display sequence in the viewing tile will follow the rules for **Block Mode**.

(A subsequent alarm can be similarly opened in another ‘**next available**’ tile, or dragged to a user-chosen tile, where it will also be displayed in **Block Mode**.)

While scenes from an alarm are being displayed, the user can click the OSD **pause** button and stop the cycle in order to view the single camera. Clicking **play** returns the user to the sequence.
Displaying OSD information about an Alarm

OSD text and icons indicate what alarm and which of the alarms cameras is now displaying

To enable the OSD text as shown in the image above: Go to Tools Options/Video Settings/OSD/Metadata General and select Show metadata OSD.
7 Cases - CaseBuilder Features

Note: Only available when connected to a `<%HOSTSYSTEM%>` system

The features of the CaseBuilder allow users to gather together items and put together supporting documentation and video clips into a single entity for research and investigative purposes. A Case can have added to it:

- **Clips:** Archiver Recorded Video Clips
- **Bookmarks:** Existing video bookmarks (with text) and the video before and after the bookmark
- **Incidents:** Information about existing incidents and related content
- **Alarms:** Alarms and the supporting alarm information, descriptions (resolution) and procedures if they exist
- **URLs:** Allows the inclusion of hyperlinks to HTTP content.
- **Snapshots:** Allows the inclusion of snapshots (frame capture to image file) from a clip being viewed in the CaseBuilder Layout.
- **Files:** Allows including user selected files in a case. No restriction on file types.
  
  For example, material might include exported DVT files, readme instructions, letters to the user, audio clips, previously captured snapshots (from the Default Layout), etc.

The following image shows the CaseBuilder Mode interface and its features:
For more information about these features, see the following:

- CaseBuilder Navigation Tree Toolbar
- CaseBuilder Navigation Tree
- CaseBuilder Query Pane (How to open a saved case)
- CaseBuilder Layout
- Query Results Pane

## 7.1 Building a Case in CaseBuilder Mode

**Note: Only available when connected to a `<%HOSTSYSTEM%>` system**

The CaseBuilder allows you to put together and label the various components of a case and then save that case to the CaseBuilder server.

### A created case has the following settings and properties:

1. Case Name - a short descriptive name of the case
2. Serial number - a unique ID number assigned to the case when it is saved.
3. Case Time - The range of dates (times) when a case began and when it was closed
4. Creation Time - The range of dates from when a case was first created to the last time a case was modified
5. Creator Name - The name of the logged in user who created the case.
6. Custom Fields - a group of three fields that allow the entry of values for each case.
   **Note:** The CaseBuilder Server definition in the AdminCenter allows these fields to be given meaningful names.
7. Description - an optional field for entering a description of the case.
8. Status - Specifies the status of the case and whether it has been exported (Created/Exported Successfully/Export failed)

### In this section the following topics are discussed:

- Opening a Saved Case in CaseBuilder Mode
- Adding an Existing Clip to a Case and Adding a Clip Segment to a Case
- Adding an Existing Clip Bookmark to a Case
- Adding an Existing Alarm to a Case
- Adding a New Snapshot (on-the-fly) to a Case
- Adding an Existing Incident to a Case
- Adding a File to a Case (documents, images, exports, etc.)
- Adding a URL to a Case
- Opening and Viewing an Exported Case

#### 7.1.1 Adding an Existing Clip to a Case

**Note: Only available when connected to a `<%HOSTSYSTEM%>` system**

You can add an entire existing recorded clip recorded by an Archiver, by searching for the clip and adding it to a case.

A clip that is added to a case has the following settings and properties:

- **Clip File Name** - a short descriptive name of the clip
Cases - CaseBuilder Features

- **Clip Time** - The range of Date/Time(s) that mark the beginning and end of a clip.
- **Scene Name** and **Logical ID** - this is the scene that was the video source which the clip was recorded from.
- **File Size** - The size in MB of the video clip
- **Description** - an optional field for entering a description of the clip.

**Tip:** If the clip only contains small segments of interest that are useful to the case, consider adding only the segment. This can be done using bookmarks (Bookmark query) and adding them to the case or by marking the in and out times of the clip (Viewing the clip and setting in and out times).

For more information, see [Adding a Clip Segment to a Case](#).

**To Add an Existing Archiver Recorded Clip to a Case:**

1. Click the Side-Bar menu, select **CaseBuilder** and then on the bottom toolbar, click ![search](image) and do the following:
   a. In the Query pane, from the Search for menu, select **Clip**.
   b. Select the recorded source scene, by marking the tree entities.
   c. From the Date and Time menu, select a preset time option or select **Manual selection** and then enter From date and time and To date and time.
   d. Click **Go**.
2. From the results that display in the Query Results pane, select the clip you want to add.
3. Click **Add to case** and if prompted about the duration of the clip, click **Yes** to add the clip. (Clip length exceeds the Tools ► Options ► CaseBuilder duration limit.)
   The case will display in the CaseBuilder navigation tree and in the CaseBuilder layout.
4. In the Clip Properties, enter an optional new name in the Clip File Name field and option description in the Description field.
5. Click ![add clip](image).

**7.1.2 Adding an Existing Clip Bookmark to a Case**

**Note: Only available when connected to a `<%HOSTSYSTEM%> system**

You can search and add existing video bookmarks to a case which will include the video segment that surrounds the bookmark. This will be a clip whose length is determined by the settings defined in the Options CaseBuilder settings.

A bookmark added to a case includes the following features and properties:
- **Clip File Name** – the `<%HOSTSYSTEM%>` bookmark name.
- **Description** - a long description for the bookmark
- **Bookmark time** - The time and date stamp that the bookmark represents on the recorded clip timeline
- **Related clip** - the video clip from the scene before and after the bookmark (This shows a child entity of the bookmark and contains Case Clip Properties)
To add an existing Bookmark to a case:

1. Click the Side-Bar menu arrow and from the Side-Bar menu, select CaseBuilder.
   
a. From the Explorer area on the bottom toolbar, click and do the following in the Query pane:
   
b. From the Search for menu, select Bookmark.
   
c. Select the recorded source scene, by marking the tree entities.
   
d. From the Date and Time menu, select a preset time option or select Manual selection and then enter From date and time and To date and time.
   
e. Click Go.

2. From the results that display in the Query Results pane, select the Bookmark you want to add.

3. Click Add to case.

The bookmark and associated clip appear in the CaseBuilder Navigation Tree.

4. In the CaseBuilder Navigation Tree, double click the bookmark

The Bookmark properties display in the CaseBuilder layout.

Tip: If the video playback does not show properly, it may help to minimize and restore the ControlCenter window to refresh the display.

5. Make any optional changes to the Description and Bookmark Name properties and then click.

7.1.3 Adding a New Snapshot (on-the-fly) to a Case

Note: Only available when connected to a <%HOSTSYSTEM%> system

You can add to a case a snapshot image of a video loaded in the CaseBuilder display window. An added Snapshot has the following features and properties:

- Snapshot File Name – Name for the snapshot image.
- Description - Optional short description area for the image
- Scene Name and Logical ID - Name of the scene that was the video source from which the image was grabbed.
- Snapshot Time - Date stamp from the video frame that the image represents

Note: Snapshots that are taken from a video that was displayed in the Monitor Mode on the Default Layout, cannot be added to a case as a “snapshot” but can be added as a file. For more information, see Adding an Existing Snapshot to a Case (Monitor-Tile).
To add an on-the-fly snapshot to a Case:

1. From the Side-Bar menu, select CaseBuilder and then on the bottom toolbar, click  and do the following:
   a. From the Search for menu, select Clip.
   b. Select the recorded source scene, by marking the tree entities.
   c. From the Date and Time menu, select a preset time option or select Manual selection and then enter the From date and time and the To date and time.
   d. Click Go.
2. From the results that display in the Query Results pane, click and drag the clip you want to add into the viewing window of the CaseBuilder Layout. The clip will load in the CaseBuilder Layout window, automatically display the Timeline pane, and start playing.
3. Right-click the video playing in the CaseBuilder window and select Add snapshot to case. The snapshot image appears in the CaseBuilder Navigation Tree.
4. In the CaseBuilder Navigation Tree, double click the snapshot image. The Case Snapshot Properties appear in the CaseBuilder Layout and the image displays in the CaseBuilder window.
5. Make any optional changes to the Description and Snapshot File Name properties and then click .

7.1.3.1 Adding an Existing Alarm to a Case

Note: Only available when connected to a <HOSTSYSTEM> system

You can add existing "cleared" alarms to a case. It should be noted that Active, Snoozed, and Accepted have not been considered acknowledged and are not available to be searched or added to a case.

An added Alarm in a case includes the following information about the alarm:

- **Alarm Instance Name** – The name of the Alarm. (By default this is the configured alarm type.)
- **Triggered Time** – The time that the Alarm became active and was initiated
- **Acknowledged Time** – The time the Alarm was cleared.
- **Acknowledged By** – The logged in user who Cleared the alarm.
- **Description** – optional description
- **Linked Procedure URL** - If a procedure URL this will be a child entity of the Alarm in the case and can be clicked by the user to see the URL content in the viewing pane.

**Tip:** If you have a linked procedure that is a HTML page on the network and the viewer of the case will not have access (link will be broken), you may want to add this content as a file to the case.
To Add an Existing Alarm to a Case:
1. Click the Side-Bar menu arrow and from the Side-Bar menu, select CaseBuilder.
2. From the Explorer area on the bottom toolbar, click and do the following in the Query pane:
   a. From the Search for menu, select Alarm.
   b. Select the Alarm type from the Query tree.
   c. From the Date and Time menu, select a preset time option or select Manual selection and then enter From date and time and To date and time.
   d. Click Go.
3. From the results that display in the Query Results pane, select the Alarm you want to add.
4. Click Add to case.
   The Alarm and any associated Procedure appear in the CaseBuilder Navigation Tree.
5. In the CaseBuilder Navigation Tree, double click the Alarm.
   The Alarm Properties display in the CaseBuilder layout.
6. Make any optional changes to the Description and Alarm Instance Name properties and then click Save.
7. If a procedure URL for the alarm exists, double click the URL.
   The Case URL Properties display in the CaseBuilder layout.
7.1.3.2 Adding a Clip Segment to a Case

Note: Only available when connected to a {%HOSTSYSTEM%} system
You can select and add only partial segments of an existing Archiver recorded clip to a case. Unlike the bookmark addition, that takes a predefined (setting in CaseBuilder options) range of time around the bookmark, the CaseBuilder feature allows you to manually select the times of the clip you want to add. This can be done in two ways, either by marking a CaseBuilder displayed clip in the timeline pane using Mark In and Mark out or by setting the Start Time and End Time in the CaseBuilder Layout Clip Time menus.
To Add a Clip Segment to a Case:

1. From the Side-Bar menu, select CaseBuilder and then on the bottom toolbar, click and do the following:
   a. From the Search for menu, select Clip.
   b. Select the recorded source scene, by marking the tree entities.
   c. From the Date and Time menu, select a preset time option or select *Manual selection* and then enter From date and time and To date and time.
   d. Click Go.

2. From the results that display in the Query Results pane, drag the clip you want to add into the viewing window of the CaseBuilder Layout.
   The clip loads in the CaseBuilder Layout window, automatically displaying the Timeline pane and start playing.

   Do one the following:
   a. Mark the in/start time, do one of the following:
      - From the CaseBuilder Layout Start Time menu, select the Start Time date and time.
      - In the Timeline, click , click-and-drag the playhead line to the start time and click .
   a. Mark the out/end time, do one of the following:
      - From the CaseBuilder Layout End Time menu, select the End Time date and time.
      - In the Timeline, drag the red playhead line to the end time and click .

3. Click *Add to case* and if prompted about the duration of the clip, click Yes to add the clip.
   (Clip length exceeds the Tools > Options > CaseBuilder duration limit.)
   The case will display in the CaseBuilder navigation tree and in the CaseBuilder layout.

4. In the Clip Properties, enter an optional new name in the Clip File Name field and option description in the Description field.

5. Click .

7.1.4 Adding an Existing Incident to a Case

**Note: Only available when connected to a <%HOSTSYSTEM%> system**

You can add an existing Incident to a case. When you add an incident, all supporting information attached to that incident is also attached. If there is a bookmark associated with the Incident, the incident will include the video segment surround the bookmarks as defined in the Options CaseBuilder settings.

An added incident to a case includes the following features and information:
- Incident Name - the name of the incident
- Description - Descriptive text related to or describing the incident.
- Incident Time - The time and date the incident occurred.
- Supporting info - These are added as child entities, for example a bookmark and the bookmark supported video clip.
To add an existing incident to a case:

1. From the Side-Bar menu, select CaseBuilder and then on the bottom toolbar, click ![search icon] and do the following:

2. From the Search for menu, select Incident.
   a. Select the source scene, by marking the tree entities.
   b. From the Date and Time menu, select a preset time option or select Manual selection and then enter the "From" date and time and the "To" date and time.
   c. Click Go.

2. From the results that display in the Query Results pane, select the Incident you want to add.

3. Click Add to case.
   The Incident and any associated child entities appear in the CaseBuilder Navigation Tree.

4. In the CaseBuilder Navigation Tree, double click the Incident.
   The Incident Properties display in the CaseBuilder layout.

5. Make any optional changes to the Description and Incident Name properties, then click Save.

6. If child entities for the Incident exist, double click each and modify the properties as needed in the CaseBuilder layout.

7. When finished, click ![save icon].

7.1.5 Adding a File to a Case (documents, images, exports, etc.)

Note: Only available when connected to a <%HOSTSYSTEM%> system
You can include files in a case. Files that are included in a case can be exported and packaged along with the other case materials. Once a file is included by adding it to a case, it will appear in the case tree and can be double clicked to either launch the file in the ControlCenter CaseBuilder Layout (if a supported HTML file type) or via the workstation program associated to the file extension.

To add a file to a case:

1. From the Side-Bar menu, select CaseBuilder.

2. From CaseBuilder Navigation Tree Toolbar, click the Add icon ![file icon] and select File.

   An Open dialog appears.

3. In the Open file dialog, select the file you want to add and click Open.
   The selected file appears in the CaseBuilder Navigation Tree.

4. Click ![save icon].

   Note: If you double click the file in the CaseBuilder Navigation Tree, it will either open in the CaseBuilder layout window (HTML based content) or the application assigned to open that file extension on the workstation will launch and open the file.
7.1.5.1 Adding an Existing Snapshot to a Case (Monitor-Tile)

**Note: Only available when connected to a <%HOSTSYSTEM%> system**

The CaseBuilder allows adding snapshots on the fly to the Case directly from the CaseBuilder Layout window, however there may be snapshots that were previously taken during monitoring. The CaseBuilder does not allow adding previously taken snapshots to the case as "snapshots" but they can be added as files. Snapshots taken during monitoring are stored in the location specified in the Options dialog.

**To locate the folder in which your snapshots are saved**

- From the main menu, select Tools/Options.
- In the Options dialog, click Export/Snapshot. The snapshot option settings are displayed.
- The Saved Location field displays the path of the folder in which your snapshots are saved.

**To add an existing snapshot as a file to a case:**

1. From CaseBuilder Navigation Tree Toolbar, click the Add icon and select File

   ![Add File Icon](image1)

2. An Open dialog appears.
3. In the Open file dialog, select the file you want to add and click Open. The selected file appears in the CaseBuilder Navigation Tree.
4. Click ![Open Icon](image2).
   
   **Note:** If you double click the file in the CaseBuilder Navigation Tree, it will either open in the CaseBuilder layout window (HTML based content) or the application assigned to open that file extension on the workstation will launch and open the file.

7.1.6 Adding a URL to a Case

**Note: Only available when connected to a <%HOSTSYSTEM%> system**

You can add a URL link to a case. Once a URL link is added to a case you can add a description as needed.

You can enter any valid HTML HREF/URL (mailto: file:, etc.)

**To add a URL to a case:**

1. From the Side-Bar menu, select CaseBuilder.
2. From CaseBuilder Navigation Tree Toolbar, click the Add icon and select URL.
   
   ![Add URL Icon](image3)

3. In the Add URL dialog, select type the URL address you want to add and click OK. The URL appears in the CaseBuilder Navigation Tree.
4. Click ![Open URL Icon](image4).
   
   **Note:** If you double click the file in the CaseBuilder Navigation Tree, it will either open in the CaseBuilder layout window (HTML based content) or the application assigned to open that file extension on the workstation will launch and open the file.
7.2 Opening a Saved Case

Note: Only available when connected to a <%HOSTSYSTEM%> system
You can open an existing case that you previously saved by searching the CaseBuilder stored cases and loading it from the search results. For information on opening and viewing an exported case, see Opening and Editing an Exported Case.

To open a saved case:
1. Click the Side-Bar menu arrow and from the Side-Bar menu, select CaseBuilder and in the CaseBuilder Query Pane do the following:
   a. Enter optional search parameters:
      - Enter a full or partial case name in the Case Name field.
      - Enter a full or partial serial number in the Serial Number field.
      - From the Created by menu, mark one or more creator sources.
   b. In the Case time range select:
      - Start Time date
      - End Time date
      - Start Time hour and minute
      - End Time hour and minute
   c. In the Description field, enter an optional description text.
   d. Click Go.
2. From the results that display in the Query Results pane, double-click the case you want to open.
   The case will display in the CaseBuilder navigation tree and in the CaseBuilder layout.

7.2.1 Opening and Viewing an Exported Case

Note: Only available when connected to a <%HOSTSYSTEM%> system
You can open and view an exported case file for viewing and playback. An exported case file does not allow editing.

To open and view an exported case file:
1. Click the Side-Bar menu, select CaseBuilder.
2. From the CaseBuilder Navigation Tree Toolbar, click .
   The Open Exported Case dialog appears.
3. In the Open Exported Case dialog, select case file and click Open.
4. Use the CaseBuilder Navigation Tree to select and view the components in the CaseBuilder Layout.
   Note: The attached files of a case can be found in the compressed file Documents folders.
7.3 Exporting a Case

**Note: Only available when connected to a `<%HOSTSYSTEM%>` system**

You can query existing cases and then export them from the Query Results pane. Exported cases can be exported with or without an included player based on the settings for CaseBuilder in the Options dialog found in the Tools menu.

**To export a case:**

1. Click the Side-Bar menu arrow and from the Side-Bar menu, select CaseBuilder and in the CaseBuilder Query Pane do the following:
   a. Enter optional search parameters:
      - Enter a full or partial case name in the Case Name field.
      - Enter a full or partial serial number in the Serial Number field.
      - From the Created by menu, mark one or more creator sources
   b. In the Case time range select:
      - Start Time date
      - End Time date
      - Start Time hour and minute
      - End Time hour and minute
   c. In the Description Field, enter an optional description text.
   d. Click Go.
2. From the results that display in the Query Results pane, select the case you want to export.
3. Click Export.
   The Browse for Folder dialog appears.
4. In the Browse for Folder dialog, select the location where you want to export the case and click OK.

**Note:** If a case is exported with a privacy mask, the global Privacy Mask Password must be used to remove the privacy mask.

7.3.1 Adding an Exported DVT Clip to a Case

**Note: Only available when connected to a `<%HOSTSYSTEM%>` system**

The CaseBuilder allows adding video clips to a Case from the Archiver recordings, via search results. This is limited to the Archivers to which the logged-in user of the ControlCenter has access.

If a clip needs to be added from a scene source other than those available, this can be done by first exporting the file, and then attaching it to the case as a file.

It should be noted that DVT files that have privacy mask passwords will need the relevant passwords if they are to be opened by remote users. Thus you will need to send the passwords needed for the Privacy Mask whenever needed.

You may want to create and include a text readme file with the appropriate information and passwords as needed.
Exporting a Case

The CaseBuilder does not allow adding exported clips to the case as "Clips" but they can be added as "files".

**To add an exported video clip file to a case:**

1. From the Side-Bar menu, select CaseBuilder.

2. From CaseBuilder Navigation Tree Toolbar, click and select File. An Open dialog appears.

3. In the Open file dialog, select the exported clip file you want to add and click Open. The selected file appears in the CaseBuilder Navigation Tree.

4. Click .

   **Note:** If you double click the file in the CaseBuilder Navigation Tree, it will either open in the CaseBuilder layout window (HTML based content) or the application assigned to open that file extension on the workstation will launch and open the file.

### 7.4 CaseBuilder Options

**Note: Only available when connected to a <%HOSTSYSTEM%> system**

The CaseBuilder options are settings that allow you to define the behavior of some of the features used to build and manage a case.

The following table describes the settings in the CaseBuilder Options:

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark Clip Settings</td>
<td>These are settings that control how much prerecorded video before and after a bookmark is included as a video clip when a bookmark is added to</td>
</tr>
</tbody>
</table>
Before
Determines the start time of the video clip (mark in) to be included with the bookmark by specifying number of seconds prior to the time of the bookmark. This is the first of two time values of a range that determine the length of the clip added to the case when a bookmark is added.

After
Determines the end time of the video clip (mark out) to be included with the bookmark by specifying number of seconds after the time of the bookmark. This is the second of two time values of a range that determine the length of the clip added to the case when a bookmark is added.

Life Span
This is the time-frame that the case will remain valid. After this time the case will be eligible to be overwritten.

Clip Duration Limit - Show warning when attached clip length exceeds duration limit.
This is a selection that enables the prompting of the CaseBuilder user when the attempt to add a clip that exceeds the maximum length specified here. This is used to help inform a user that a clip may be too long and should be trimmed. The user may still choose to add the clip or cancel the action when prompted.

Include Player
This option, when enabled, assures that in every exported Case contains a Quick ControlCenter player for viewing a case file. The application is stored inside the compressed case file package. (zip file)

<table>
<thead>
<tr>
<th>To change CaseBuilder Options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. From the main menu, select Tools ► Options.</td>
</tr>
<tr>
<td>2. In the Options dialog, select CaseBuilder, and make changes as needed.</td>
</tr>
<tr>
<td>3. When finished, click OK.</td>
</tr>
</tbody>
</table>
- P -
Panoramic Cameras 111
Picture-in-Picture 86
PIP 86
Playback 24
preset 12
Privacy Mask 74, 106, 133
Privacy Masking 12
PTZ 40
PTZ Pane 68

- Q -
Query 12
Query Pane 58
Quick View 100
Quick View enabled in a Pane 101
Quick View in Playback 104

- S -
Scene Tracker 39
Screening 86
Scrubbing 130
Selecting a Segment 128
Sidebar 16
smooth playback 24
Snapshot 12, 35
Spot Monitor 12, 109
streaming buffer length 24
Switch to Live 12
Synchronized Playback 119
synchronous 24

- T -
TCP or UDP 24
Thermal 86
Thumbnail 96
Thumbnail Search 84, 96
Time Ruler 128
Time Scale 128
Timeline scale 131
Timestamp 24
Timestamp buffer 24

- U -
USB Joystick 51
Using Quick View 102

- V -
Video Buffering 24
View Settings 28
Viewing Pane 81

- W -
Workspace 9

- Z -
zooming 128